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About DMTI Spatial "

DMTI Spatial Inc. is Canada’s leading spatial solutions provider. We enable users to understand their
customers, optimize resources, realize opportunities, maximize profitability and make more informed
decisions through accurate products and innovative thinking.

DMTI Spatial publishes precision built street map, rail and routing data (CanMap®), a detailed water layer,
and innovative geocoding and address management software (GeoPinpoint”). In addition, DMTI Spatial
publishes a full range of positionally accurate geospatial data products including: enhanced points of
interest (EPOI), census data and boundaries, postal geography, topographic maps, and US mapping
data. As part of a complete business geographic solution, DMTI Spatial offers a wide range of GIS
services, consulting, and software training.

Established in 1994, DMTI Spatial is committed to setting the standard within the GIS industry for
precision built spatial data and geocoding software products.

At DMTI Spatial, we believe that our true strength comes from working closely with our customers and
providing innovative solutions to meet their strategic business objectives. As Canada’s premier spatial
solutions provider we pride ourselves with having worked with North America’s leading organizations to
support their mission critical applications.

DMTI Spatial works with large and small organizations representative of a wide variety of industries:

e Agriculture e Forestry e Mining

e Banking/Finance e Government e Real Estate

e Consulting e Health e Retalil

e Education e High Technology e Telecommunications
e Emergency Services e Insurance e Transportation

e Engineering e Manufacturing e Utilities

e Environmental e Media

We are a member of the ESRI Canada Business Partner Program, and winner of the 2001 ESRI
Worldwide New Business Partner of the Year Award and the 2005 ESRI Foundation Partner of the Year
Award. We are a strategic business partner of Mapinfo and winner of the Markham Board of Trade 2000
Award for Entrepreneurship and Innovation. Recipient of The Association of Canadian Map Libraries and
Archives (ACMLA) 2002 Certificate of Appreciation.

.ZMaplnio

Business Partner
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Really Smart Spatial Solutions™

Page 2

Through the application of its products and services, DMTI Spatial has been involved with projects such
as: location-based services, logistics planning, emergency dispatch, facilities management, data
management, customer care, address management, land base development in support of network
planning, and marketing/demographic analysis applications.

DMTI Spatial can provide all of the components necessary for the acquisition, implementation, operation
and maintenance of a successful GIS system within companies of all sizes. Through its product and
service offering, DMTI Spatial can provide users with 5 key components:

1. Accurate, detailed, and compatible data
2. Comprehensive maintenance program
3. GIS software

DMTI Spatial™ Product & Service Portfolio

DMTI Spatial’s product & service offering
includes:

CanMap® - Digital Map Data for Canada
CanMap® Streetfiles

CanMap® RouteLogistics

CanMap® Rail

CanMap® Major Roads and Highways
CanMap® Parks & Recreation
CanMap® Water

Satellite Imagery
e Satellite StreetView™

Municipal Amalgamations
e CanMap® Municipality Amalgamation File
(MAF)

Business & Recreational Points of Interest
¢ Enhanced Points Of Interest (EPOI)

GeoPinpoint™ Suite

e Canada’s Geocoding Solution

e Modular Architecture

e Windows Standalone Desktop Version

e UNIX, Java Wrapper, ActiveX (DLL Version)

Topographic Data and Base Maps

e Canadian Atlas Map Bundle (CAMB)
Populated Placenames

National Topographic Data Base (NTDB)
30 & 90m Digital Elevation Models (DEM)
Clutter Data

Postal Geography & Data

e Six-Digit Postal Code File (LDU)

e Enhanced Postal Code File (MEP)

e Forward Sortation Areas (FSA) Boundary
File

www.dmtispatial.com

4. Consulting and services
5. Software training

1996 Census Boundaries & Demographic Data

e Enumeration Area (EA)

e Census Subdivision (CSD)

e Census Division (CD)

e Census Metropolitan Area/Census
Agglomeration (CMA/CA)

e Census Tract (CT)

e Federal Electoral Districts (FED)

2001 Census Boundaries

e Dissemination Area (DA)

e Census Subdivision (CSD)

e Census Division (CD)

o Census Metropolitan Area/Census
Agglomeration (CMA/CA)

e Census Tract (CT)

e Federal Electoral Districts (FED)

GIS Software

e Contour Modeling and Display

e Demographic Profiling and Lifestyle Targeting
e Geocoding and Mapping Software

¢ Routing and Logistics

Consulting and Services
Application Development
Database Marketing

Data Conversion and Creation
Database Scrubbing
Geocoding Services

GIS Consulting

Technical Support

Proprietary and Confidential to DMTI Spatial
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Technical Support, Error Reporting & Product Enhancement Services

DMTI Spatial is committed to building the best products possible for our customers. By using our data
every day in your mission critical application you are our best source for product refinement. Please let
us know if you have an enhancement request or found an error in any of our products so that we can
make the correction for the next release.

This is your opportunity to provide feedback directly to the DMTI Spatial Product Development Team.
Please be as specific as possible so that we can improve our products quickly and accurately. To submit
an error or request technical assistance please visit: http://www.dmtispatial.com/support/

If you have an idea for a new product, or an enhancement request for an existing product, please visit our
product manger’s desk on the web at: http://www.dmtispatial.com/pm/
or e-mail: pm@dmtispatial.com

Contact Information

DMTI Spatial Inc.
625 Cochrane Drive, 3rd Floor
Markham, Ontario
L3R 9R9 Canada

Telephone: 905-948-2000
Toll Free: 1-877-477-DMTI (3684)
Fax: 905-948-9404

Web Site: www.dmtispatial.com

Error Reporting Service: fixme@dmtispatial.com
Product Enhancement Requests: pm@dmtispatial.com
Technical Support: support@dmtispatial.com

Trademarks and Notices

© 2005 DMTI Spatial Inc. CanMap is a registered trademark of DMTI Spatial Inc. DMTI Spatial, Really
Smart Spatial Solutions, Because Where Is What Matters and GeoPinpoint are trademarks of DMTI
Spatial Inc. All rights reserved. Other products and company names mentioned herein may be
trademarks of their respective companies. Mention of third-party products is for informational purposes
only and constitutes neither a recommendation nor an endorsement.

DMTI Spatial is an Authorized User and Distributor of selected Statistics Canada Computer File(s) under
Licensing Agreement 6228. No confidential information about an individual, family, household,
organization or business has been obtained from Statistics Canada.

© Copyright, HER MAJESTY THE QUEEN IN RIGHT OF CANADA, as represented by the Minister of
Industry, Statistics Canada 2003.

Digital Topographic Data produced under License from Her Majesty the Queen in Right of Canada, with
permission of Natural Resources Canada and The Queen in Right of Manitoba.

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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About EPOI v2007.3

File Properties

Property Description

Coverage Nationwide

Currency May 15, 2007

Format ASCII text files (comma delimited)”

File Naming Conventions

Representing the data coverage, files are either named by a region, Statistics Canada census subdivision
(CSD) number, or a Standard Industrial Classification.

File Names by Region

For example:  \On.txt

v

Geographic Area Abbreviation®
ON

File Names by 1996 Census Subdivision (CSD)

Census Subdivision is the general term applied to municipalities (as determined by provincial legislation)
or their equivalent, for example Indian reserves, Indian settlements and unorganized territories.

All files are prefixed with the Census Subdivision Code. An additional text file (CSD.txt) containing a CSD
and its associated municipality name is included in each order by CSD.

For example: \3520004_A.txt

R

Census Subdivision File Name
3520004 (Toronto) A (Division A)

File Names by Standard Industrial Classification (SIC)
Orders by SIC will contain the SIC specification of the data purchased in the file name.?

For example: \OnA.txt

/\

Geographic Area Abbreviation File Name
ON A (SIC Division A)

! See Appendix A: Importing Data Into GIS Software for information on how to import EPOI files into GIS software (including
Maplnfo, ArcView 3.x, and ArcGIS 8.1).

2 See Appendix B: Provincial and Territorial Abbreviations and Codes and Appendix C: Canadian Urban Areas and Abbreviations for
a list of region names and their abbreviations.

® For a list of File Name abbreviations, refer to Appendix D: Standard Classification (SIC) Codes.

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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File Names of EPOI Look Up Tables

- Page 5

Look up tables contain information such as; the number of beds in a hospital, the location code of an
airport, and the grade range taught within a school. Look up tables are linked to the main table via the
POIL_ID field. For example, a record in the POI database that has an EPOI_TYPE = POL (Police
Services) links via the POI_ID field to the “pol” (Police Services) look up table.

EPOI and EPOI Look Up Table Examples

EPOI File EPOI Look Up Table |Description

OnJ.TXT OnJ_POL.txt Ontario by SIC Division “J” (Public Administration)

On92.txt On92_ POL.txt Ontario by SIC Major Group “92” (Justice, Public Order, And
Safety)

0On9221.txt 0On9221 POL.txt Ontario by SIC Code “9221" (Police Protection)

Enhanced attribution can be found in the following look up tables.

EPOI_TYPE EPOI_TYPE Description
Classification

ACC Accommodation

AER Aerodromes

BLD Building Names

BOR Border Crossings & Customs Offices
CAR Car Rental Agencies

CIN Cinemas

CPL Car Pool Parking Lots
EDU Education

FIN Financial Institutions
FRE Fire Stations

GAS Gasoline Service Stations
GLF Golf Courses

HCR Health Care

POL Police Services

RPO Retail Postal Outlets
SHP Shopping Centres

SKI Ski Centres

TOL Toll Booths

TOU Tourist

TRS Transit Stops

WGH Weigh Stations

EPOI File Structure

Field Name Field Type Field Size |Field Description

POI_ID Character 15 Unique ID

NAME Character 150 Name

UNIT_SUITE Character 25 Unit or Suite #

ADDRESS Character 45 Address

DELIV_MODE Character 25 General Delivery Address (i.e. PO BOX)

www.dmtispatial.com
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CITY Character 68 City or Municipality

PROV Character 2 Province

POST CODE Character 7 Postal Code

LOCATION Character 100 Description of location

PHONE Character 15 Phone Number

FAX Character 15 Fax Number

TOLL FREE Character 15 Toll Free Number

EPOI TYPE Character 3 Three letter abbreviation of EPOI type

CAF Character 15 Common Address Flag

SIC 1 Character 8 Standard Industrial Classification - Primary

SIC 2 Character 8 Standard Industrial Classification

SIC 3 Character 8 Standard Industrial Classification

SIC 4 Character 8 Standard Industrial Classification

SIC 5 Character 8 Standard Industrial Classification

SIC 6 Character 8 Standard Industrial Classification

SIC_MJ _GRP Character 2 Standard Industrial Classification Major Group
SIC DIV Character 1 Standard Industrial Classification Division Group
X Number Longitude

Y Number Latitude

PREC_CODE Character 2 Precision code indicating accuracy of geocoded point
ATTRIBCODE Character 2 Attribution code indicating the accuracy of attribute data

Common Address Flag (CAF)

It is common for businesses or other recreational facilities to share addresses, for example in skyscrapers
or shopping centers. The EPOI product has a feature that allows users to identify records that have
common addresses. A group by query on the CAF field will allow a user to extract a single record by
address. The CAF is an alphanumeric code that is unique to a unique address.

NAME ADDRESS SIC PHONE |[CAF

Business 1 10 Main St. A 1 ADD1
Business 2 10 Main St. B 2 ADD1
Business 3 10 Main St. C 3 ADD1
Business 4 1 King St. D 4 ADD2
Business 5 1 King St. E 5 ADD2

The CAF is only applied to records that have an address. Some DMTI-sourced records (AttribCode = “1")
do not have an address and therefore the CAF field is blank.
Precision Code (PREC_CODE)

Value Description

Centroid of 1:50 000 NTDB feature or placed via Orthorectified photo

Block-face representative point from CanMap streets - High precision

Block-face representative point from CanMap streets - Lower precision

Postal Code - Block-face representative point

Postal Code - EA Centroid / FSA Centroid

OO |R|WIN|F

Municipal Centroid

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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Attribution Code (ATTRIBCODE)

Value Description
1 DMTI Spatial sourcing
2 Other sourcing — High confidence (Validated by DMTI Spatial)

EPOI Look Up Table Specifications

Look Up Tables link to the main database via EPOI_TYPE and POI_ID for enhanced attribution.
Enhanced attribution can be found in the following look up tables.

EPOI_TYPE EPOI_TYPE Description
Classification

ACC Accommodation

AER Aerodromes

BLD Building Names

BOR Border Crossings & Customs Offices
CAR Car Rental Agencies

CIN Cinemas

CPL Car Pool Parking Lots
EDU Education

FIN Financial Institutions

FRE Fire Stations

GAS Gasoline Service Stations
GLF Golf Courses

HCR Health Care

POL Police Services

TOL Toll Booths

TOU Tourist

TRS Transit Stops

WGH Weigh Stations

SIC Look Up Tables link to the main database via SIC Division or SIC Major Group.

Look Up Table Look Up Table Description
sic_mjgrp_desc SIC Major Group Descriptions
sic_div_desc SIC Division Descriptions
www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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SIC Division Descriptions (sic_div_desc)
The SIC Division Description table includes the description of all SIC Divisions that exist in the file.

File Structure

Field Name Field Type |Field Size Field Description
SIC DIV Character 1 SIC Division Group
DESCRIPTION Character 150 Description of SIC Division

SIC Major Group Descriptions (sic_mjgrp_desc)

The SIC Major Group Description table includes the description of all SIC Major Groups that exist in the
file.

File Structure

Field Name Field Type |Field Size Field Description

SIC_MJ GRP Character 2 SIC Major Group
DESCRIPTION Character 150 Description of SIC Major Group
www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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Data Dictionary

Page 9

Accommodation (acc)

The accommodation layer includes hotels, motels, and inns.

File Structure

Field Name Field Type |Field Size Field Description

POI ID Character 15 Unigue ID (link to main POI database)
EPOI TYPE Character 3 Point of Interest Classification

CHAIN Character 100 Accommodation Chain

Aerodromes (aer)

The aerodromes layer includes airports, heliports, and water aerodromes.*

File Structure

Field Name Field Type [|Field Size Field Description

POIL_ID Character 15 Unique ID (link to main EPOI database)

EPOI_TYPE Character 3 Point of Interest Classification

ICAO_CODE Character 4 Location Indicator assigned by Transport Canada and the
U.S. Federal Aviation Administration (4 character)

IATA_CODE Character 3 Location indicator assigned by Transport Canada and the
U.S. Federal Aviation Administration (3 character)

AER_TYPE Character 10 Type of Aerodrome

STATUS Character 10 Operational Status of Aerodrome. Indicates if the
aerodrome is operational or abandoned.

NAME_ALIAS |Character 125 Alternate name of Aerodrome

X1 Number Longitude of first or main entrance point (Terminal 1)

Y1 Number Latitude of first or main entrance point (Terminal 1)

X2 Number Longitude of second entrance point (Terminal 2)

Y2 Number Latitude of second entrance point (Terminal 2)

X3 Number Longitude of third entrance point (Terminal 3)

Y3 Number Latitude of third entrance point (Terminal 3)

Contents

AER_TYPE Description

LAND Aerodromes that provide an advantage for the aviation community are included. This
includes aerodromes that are open to the public, are used by more than one aircraft
and have a telephone available for users of the aerodrome.

WATER Water aerodromes that provide an advantage for the aviation community are
included, typically this includes aerodromes that are open to the public, are used by
more than one aircraft, have an area for docking or beaching with tie downs and have
a telephone available for users of the aerodrome.

HELIPORT Heliports that provide an advantage for the aviation community are included. This

includes heliports that are open to the public, are used by more than one aircraft and

! Source: Geomatics Canada, Canada Flight Supplement and Canada Water Aerodrome Supplement (WAS), March 2003

www.dmtispatial.com
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Page 10

| have a telephone available for users of the heliport.

Name and Name_Alias

The Name field contains the names of aerodromes and indicates what communities they may serve. The
Name_Alias field provides an alias for the aerodrome. For example:

Name City Name Alias

Toronto/Lester B. Pearson Intl Toronto Lester B Pearson International Airport
Montréal/St-Hubert Montréal Aeroport de Saint-Hubert
Calgary/Springbank Calgary Calgary Springbank Airport

Building Names (bld)

The Building Names layer includes building names and building types.

File Structure

Field Name Field Type [Field Size |Field Description
POIL_ID Character |15 Unique ID (link to main EPOI database)
EPOI_TYPE Character (3 Point of Interest Classification

SUITE_FROM_NUM

Character |25

The lowest value in a range of suites or apartments

SUITE_TO_NUM

Character 25

The highest value in a range of suites or apartments

BUILD_TYPE

Character |11

Representation of whether the building is a business
building or an apartment building

Border Crossings & Customs Offices (bor)

The Borders Crossings and Customs Offices layer includes independent offices, subordinate offices,

service sites, and warehouses.

File Structure

Field Name Field Type [Field Size Field Description
POIL_ID Character 15 Unique ID (link to main EPOI database)
EPOI_TYPE Character 3 Point of Interest Classification
BOR TYPE Character 10 Ind|c_ates !f a port is an Independent, a Subordinate or a
- Service Site
PORT_NO Character 5 The number of the Independent Port
REP TO Character a5 The name and numper of the Independent Port that a
- Subordinate or Service site reports to
Indicates if a portis a HUB or not. A HUB is an
HUB Character 1 independent office to which a subordinate office would
report.
SERVICES Character 45 Types of services available at that port*
US_PORT Character 20 Name of the US Customs Office opposite to the Canadian

Customs Office

! Detailed information regarding customs operations, the hours and types of services available at custom offices, definitions of
terms, and abbreviations used in the Services field, can be found in Appendix E: Border Crossings and Customs Offices.

www.dmtispatial.com
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Page 11

Contents
BOR_TYPE Description
IND Independent Offices
SER Service Sites
SUB Subordinate Offices

Car Rental Agencies (car)

The Car Rental Agencies layer includes the following Car Rental Agencies: Alamo, Avis, Budget,
Discount, Enterprise, Hertz, National and Thrifty.

File Structure

Field Name Field Type [Field Size Field Description

POI ID Character 15 Unigue ID (link to main EPOI database)
EPOI_TYPE Character 3 Point of Interest Classification

CHAIN Character 100 Car Rental Chain

LOC_CODE Character 10 Unique Identifier for a branch within a chain

Cinemas (cin)

The cinema layer contains cinemas across Canada.

File Structure

Field Name Field Type [Field Size Field Description

POI ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification
SCREEN_NO |Character 5 Number of screens in given theatre
PHONE_2 Character 15 Second phone number

Car Pool Parking Lots (cpl)

The Car Pool Parking Lots layer indicates the name, exit number, and location of Car Pool Parking Lots
on the Major Expressways. This layer provides data for Ontario only.

File Structure

Field Name Field Type [Field Size Field Description

POl ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification

EXIT_NUM Character 5 Hwy exit number at location of Car Pool Lot
DIRECTION Character 2 Direction of Hwy Car Pool Lot

www.dmtispatial.com
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Education (edu)
The Education layer includes Elementary Schools, High Schools, Colleges, Cégeps and Universities.

File Structure

Field Name Field Type |Field Size Field Description

POIL_ID Character 15 Unique ID (link to main EPOI database)

EPOI_TYPE Character 3 Point of Interest Classification

EDU_TYPE Character 10 Education Point of Interest Classification

DISTRICT Character 100 District where the facility resides

LEVEL Character 10 Teaching Level

LANGUAGE Character 10 Predominate or language-only type Some educational

facilities use two languages to teach, but one is usually
predominant. The dominant language is represented first.

GRADES Character 10 Grade range
Contents

EDU_TYPE |Description

CG Cégep

CL College

FN First Nations

P Public

PR Private/Independent

S Catholic (Separate)

SN Special Needs

uv University

LANGUAGE |Description

E English

F French

H Hebrew

G German

U Ukrainian

C Cree

F/E French & English

E/F English & French

E/H English & Hebrew

E/G English & German

E/U English & Ukrainian

LEVEL GRADES Description

J K-6 Junior

[ 7-8 Intermediate

S 9-12 Senior

J/ K-8 Junior/Intermediate
I/S 7-12 Intermediate/Senior
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IR

[K-12

| Junior/Intermediate/Senior |

Financial Institutions (fin)

The Financial Institutions layer includes financial institutions belonging to one of the following three
groups: (1) Banks, (2) Credit Unions and Caisses Populaires, (3) Trust Companies, Loan Companies, and

Other Deposit-Taking Institutions.

File Structure

Field Name Field Type Field Size Field Description

POIL_ID Character 15 Unique ID (link to main EPOI database)
EPOI_TYPE Character 3 Point of Interest Classification
FIN_TYPE Character 70 Type of Payment Association®

Fire Stations (fre)

The Fire Stations layer includes fire stations in the provinces of Ontario, Quebec, British Columbia,
Alberta and Saskatchewan.

File Structure

Field Name Field Type Field Size Field Description

POIL_ID Character 15 Unique ID (link to main EPOI database)
EPOI_TYPE Character 3 Point of Interest Classification
STATION Character 68 Name of Fire Station

STN_TYPE Character 3 Type of Fire Station

Gasoline Service Stations (gas)

The Gasoline Service Stations layer is comprised of six different gas companies: Husky, Irving,
PetroCanada, Pioneer, Shell, and Sunoco. Pioneer and Sunoco gas stations are provided for Ontario

only.

File Structure

Field Name Field Type Field Size Field Description

POIL_ID Character 15 Unique ID (link to main EPOI database)
EPOI_TYPE Character 3 Point of Interest Classification

CHAIN Character 100 Gas Station Chain

PROPANE Character 3 Propane Available

DIESEL Character 3 Diesel Available

! A complete listing of financial institutions, and their corresponding FIN_TYPE classification is found in Appendix F: Canadian

Payments Association Classification.
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The Golf Courses layer contains Private and Public golf courses.

File Structure

Field Name Field Size |Field Type Field Description

POI ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification

NUM HOLE Character 5 Number of Holes at Golf Course

GLF TYPE Character 15 Golf Course Point of Interest Classification

Health Care (hcr)

The Health Care layer includes Hospitals, Long-Term Care Centers, Nursing Stations, Outpatient Clinics
and Community Health Centers.

File Structure

Field Name Field Type |Field Size Field Description

POI ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification
TOTAL_BEDS Character 5 Total number of beds

HCR _TYPE Character 1 Health Care Point of Interest Classification
Contents

HCR_TYPE Description

H Acute Care Hospital

L Long-Term Care Center

N Nursing Station

0] Outpatient Clinic

C Community Health Center

Police Services (pol)*

The Police Services layer includes the Ontario Provincial Police (OPP), Royal Canadian Mounted Police
(RCMP), Sireté du Québec (SQ), the Royal Newfoundland Constabulary (RNC), and other municipal
police services.?

File Structure

Field Name Field Type |Field Size Field Description
POl ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification

;Source: CPIC National Directory, Canadian Police Information Centre, 2002.
A complete listing of abbreviations and definitions (English/ Frengh) used in the Police Services layer is found in Appendix G :

CPIC National Directory.
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STN_ADMIN Character 70 Police Station or Administrator

POL TYPE Character 10 Police Service Point of Interest Classification
Contents

POL_TYPE Description

MUN Municipal Police Service

OPP Ontario Provincial Police

RNC Royal Newfoundland Constabulary

RCMP Royal Canadian Mounted Police

SQ Sdreté du Québec

Retail Postal Outlets (rpo)
The Retail Postal Outlets layer includes over 8500 postal outlets across Canada.

Note: There is no look up table for the RPO layer. All relevant information is found in the main table.

Shopping Centers (shp)
The Shopping Centers layer includes over 2000 shopping centers across Canada.

Note: There is no look up table for the SHP layer. All relevant information is found in the main table.

Ski Centers (ski)
The Ski Centers layer is comprised of over 200 skiing facilities across Canada.

Note: There is no look up table for the SKI layer. All relevant information is found in the main table.

Toll Booths (tol)
The Toll Booths layer indicates the name and location of Toll Booths.

File Structure

Field Name |Field Type Field Size Field Description

POl ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE |Character 3 Point of Interest Classification

DIRECTION |Character 2 Direction of road that toll booth is located on
Contents

DIRECTION |Description

E East

W West

N North

S South
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The Tourist layer includes categories such as National, Provincial and Municipal parks, Art Galleries,
Attractions, Fishing Resorts, Historic Sites, Museums, Science Centres, Tourist Information Booths, and

Z00S.

File Structure

Field Name Field Type Field Size Field Description
POI ID Character 15 Unique ID (link to main EPOI database)
EPOI_TYPE Character 3 Point of Interest Classification
TOU TYPE Character 5 Tourist Point of Interest Classification
SEASON Character 50 Season that Tourist POl is open
Content
TOU_TYPE
TOU_TYPE Description TOU_TYPE Description
ACH Archive HIS Historic Site/Park/Location
ADV Outdoor Adventure LIB Library
Company/Tour MUS Museum
AQU Aquarium NAT Nature Preserve/Conservatory
ATT Attraction OBS Observatory
BCH Beach ORG Organization related to Arts
CAS Casino and Culture
CEC Cultural or Environmental PNT Planetarium
Education Center PRK Park
CuL Cultural Center RLG Religious Institution
DFS Duty-Free Shop SCI Science Centre
FSH Fishing Lodge/Camp SCN Scenic Site/Trail/Area
GAL Art Gallery TIB Tourist Information Board
GDN Garden WTS Water Tour/Cruise
GSvV Government Services 700 700

Transit Stops (trs)

The Transit Stops layer contains the Type, Owner, Route and Number (if applicable).

File Structure

Field Name Field Size |Field Type Field Description

POl ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Classification of the EPOI

TRS TYPE Character 25 Transit Stop points of interest classification
OWNER Character 68 Transit Stop points of interest ownership
ROUTE Character 68 Transit Stop points of interest transit route
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TRS NUM Character 8 Transit Stop points of interest number
CODE Number Transit Stop points of interest NTDB code
FEATURE Character 76 Transit Stop points of interest NTDB feature

Weigh Stations (wgh)

The weigh stations layer (at a minimum) contains the Name and Address (if applicable) of each weigh
station as well as the site type (permanent or portable scale).

File Structure

Field Name Field Size |Field Type Field Description

POl ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Classification of the EPOI

DIRECTION Character 2 Indicates the direction of road scale is on
HOURS Character 20 Hours of operation

YEAR ROUND |Logical Year Round Operation

RESTROOM Logical Restrooms available

WGH_TYPE Character 10 Weigh Station Point of Interest Classification
AVION401 Logical Avion 401 automated clearance system
Contents

DIRECTION |Description

N North

S South

E East

W West

O Ouest

NS North & South (can be accessed from either direction)

EW East & West (can be accessed from either direction)

WGH_Type

Value Description

Perm Permanent Scale

Port Portable Scale
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Appendix A: Importing EPOI Data in GIS Software

When importing the database please be sure to check that the X and Y fields are of the right type.

Maplinfo
Creating a MapInfo (.tab) table =]

1. Open Maplinfo.

2. File > Open Table > Select EPOL.txt file and double-click. D elimiter
3. Indialog box, for “Delimited ASCII Information” choose  Tab &+ Other: |_

‘Other’ (comma), the ‘File Character Set’ should be

“Windows US & W. Europe (“ANSI")”, and check off the File Character 5et;
. gﬁskFlorsKt Line for Column Titles. See Figure 1. [windows US & /. Europe (ANSI"] =]
5. File > Save Copy As...choose folder to save file. ¥ Use First Line for Column Titles
6. Open the new .tab file.

P Ok, I Cancel Help |
Creating MapInfo Graphics from Coordinate Fields - — -

7. Table > Create Points > Select EPOI.tab file Figure 1: Delimited ASCII Information
8. Adjust the symbol size, colour, and shape by selecting

“Symbol Style”.

9. Choose the “x” field in the ‘Get X Coordinates from Column’ in the drop down box.

10. Choose the “y” field in the ‘Get Y Coordinates from Column’ in the drop down box.

11. Click on Projection, select the Category (Longitude/Latitude) and the Category Member
(Longitude/Latitude (NAD83))

12. Click OK.

Creating Mapinfo Lookup tables Main EPOI table EPOI look up table

13. Repeat steps 1 to 6

Linking the EPOI table to the EPOI Lookup tables
14. Open the EPOI table and the EPOI look up Select Columns: \ / |Tc.,b|es +

Lel

tables in Maplnfo

Ic: | :|
15. Select Query > SQL select. il
16. Click on “from Tables” box and click “Tables”, o D [6TA, GTA_ADE IDpelators :|
select the EPOI table and the look up table R T
17. Click on “where Condition” box, enter the where Condtian: -POLID=GTA_ALLPOL
condition so that the POI_ID from each table is IFWC“C'”S :I
equal.
18. Click on “into Table Named” box and name the Group by Columns: |
new file. See Figure 2. Order by Colurns: | SaveTempIatel
into Table Mamed: IGTA_Accomodatmn Load Template |
v Browse Flesults
Ok I Cancel | Clear | Werify | Help |
Figure 2: Linking the EPOI table to the EPOI Lookup
tables
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ArcView 3.x

Opening txt file(s) and making ArcView files (*.shp)
1. Open ArcView > New Project as a blank project.
2. From the Project Window, click on ‘Tables’. Click “Add”. Change the ‘List Files of Type’ to
“Delimited Text (*.txt), then navigate to the EPOIL.txt file(s). Click OK.

|

2" Untitled ! Add Table
Ty | 2dd I/' File Mame: Directaries: T |
| o hdatahaotherstemphepoiton

B ond173.t=t - = ot - Cancel |

B ond237 tat [= data

B onB521 kst [= other

B onB531 kst = temp

1 on55471 =t = epoi

B onb551.tat

B on5561 . txt

P onG571. = =
Lizt Files of Type: Drrives:

Delimited Text [*.kat] E3 [c 3|

= dBaASE [*.dbf] 1=

IMFO

Figure 3: Creating ArcView files

Creating Graphics from Coordinate Fields

3. In Project Window, click ‘Views'. Press “New” to add a view.

4. Select View > Add Event Theme. Select the correct table, and X/Y coordinate fields from the
EPOL.txt file. Click OK.

5. Inthe View select the EPOIl.txt layer to make the layer active.

6. Select Theme > Convert to Shapefile > Navigate to the location where the files will be saved.
Name the file and Click OK. When ArcView asks to add the shapefile as a theme to the view,
Press YES. The new theme with the .shp extension will appear in the view.

Creating Projection Datum Metadata (*.prj files):

7. Inthe same project, from the Menu > File > Extensions. Scroll down to Projection Utility Wizard,
click on the checkbox and Click OK.

8. File > ArcView Projection Utility. In Step 1, select the shape file and press Next. In Step 2, the
‘Coordinate System Type’ should be “Geographic”. From the ‘Name’ dropdown box, select
“GCS_North_American_1983 [4269]", and the units in “Degree [9102]", then press Next. ArcView
will ask to save the coordinate system information, press Yes and a Project file (*.prj) will be
created with the shape files. Cancel out of the Utility. To continue would actually re-project the
files.

Opening Lookup tables in ArcView:
9. Inthe same project, click from the Project Window — Tables. Press Add to bring in the lookup
table. Click Open to see the database.
10. File — Export — this will convert the text file to a dBASE format for ArcView. Select the location to
save and press OK.
11. The text version of the lookup table can be deleted from the project. Open the new dBASE file.
12. Repeat for each lookup table as required.
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Linking Lookup tables to the main EPOI table
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To view the main EPOI table linked to the Look up tables, the files should be manually joined. To join the

files use the following directions:
13.
14.
15.
16.

View both the main EPOI table and the Look up table (attribute tables)

Click on the POI_ID fields from both the main EPOI table and the Look up table

Click on the Join button (or choose Join from the Table menu).

Additional Look up tables can be joined, so that many tables’ attributes can be shown at one time.

To undo the joins between the tables, click on the attribute table, making it active, and from the

‘Table’ menu select ‘Remove All Joins'.

ArcGIS 8.3

Opening txt file(s) and Creating ArcMap files:
1. Start with a new empty map. Click OK.
2. File > Add Data > navigate to the EPOI.txt
files and Click Add.

Note: “ON”is an SQL statement in ArcGIS and
therefore ON.txt cannot be opened and must be
renamed as ONT.txt. The renaming of this file
will not affect the link to the Ontario lookup table.

Creating Graphics from Coordinate Fields:

3. Tools > Add X, Y Data > choose the table
and the X, Y fields.

4. Choose the coordinate system by clicking
Edit. Then from ‘Select Coordinate System’,
select Geographical Coordinate System, then
North America, then North American Datum
1983. Click Add, then Apply, then OK. A
project file (*.prj) is created containing the
coordinate information.

5. Make the event theme active (ie. EPOI.txt
Events).

6. Right click on the ‘Events’ theme, choose
‘Data’, then ‘Export Data’. Export all
features. Click on the ‘Use the same
Coordinate System as the data frame’ button.
Browse to specify where the theme will be
stored. Click OK.

7. ArcMap will ask to add the layer to the view.
Click Yes. Remove the ‘Events’ theme.

Opening Lookup Tables in ArcMap

foinpata

Join lets you append additional data to this layer's attribute table o vou can,
far example, sumbolize the layer's features ugsing thiz data.

‘wihat do vou want to join to this layer?

=l

IJu:uin attributes from a table

]

1. Chooze the field in this layer that the join will be bazed on:
POI_ID -

2. Choose the table o join to this laver, or load the table from disk:

[OM_55711.t =] El

¥ Show the attribute tables of layers in this list

3. Chooze the field in the table ta baze the join an:

FaI_ID

=l

Advanced... |

o]

About joining data... Cancel

Figure 4: Creating graphics from coordinate fields

8. Repeat the first two steps under “Opening txt files and creating ArcMap files” to open the Lookup
tables. Right click on the Lookup table and select ‘Open’ to view.

Linking Lookup tables to the main EPOI table

To view the main EPOI table linked to the Look up tables, the files must be manually joined together.
9. Add both the main EPOI table and Lookup table to the Layers. Right click the Lookup table and

select ‘Joins and Relates’ > ‘Join’.

10. Choose the field the join will be based on (i.e. POI_ID), then select the table to join too, and Click

OK.
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Appendix B: Provincial and Territorial Abbreviations and Codes*

The provincial/territorial names, abbreviations and numeric codes reflect those in effect on January 1,
2001 with the exception of the name change of the province of Newfoundland and Labrador (previously
Newfoundland), which came into effect on December 6, 2001. Newfoundland and Labrador was
recognized by the alpha code NL (formerly NF). There were no changes to the numeric code (10) and
abbreviations for Newfoundland and Labrador.

On April 1, 1999 the Northwest Territories was divided into two territories to create Nunavut Territory.
The provincef/territory numeric code for Nunavut is 62 whereas the code for the Northwest Territories

remained at 61. On December 18, 2000, Canada Post has introduced a new alpha code (NU) for

Nunavut.
Province/Territory (English) [Province/Territory (French) Abbreviation® [Numeric Code
Alberta Alberta AB 48
British Columbia Colombie-Britannique BC 59
Manitoba Manitoba MB 46
New Brunswick Nouveau-Brunswick NB 13
Newfoundland and Labrador [Terre-Neuve-et-Labrador NL 10
Nova Scotia Nouvelle-Ecosse NS 12
Northwest Territories Territoires du Nord-Ouest NT 61
Nunavut Nunavut NU 62
Ontario Ontario ON 35
Prince Edward Island lle-du-Prince-Edouard PE 11
Québec Québec QC 24
Saskatchewan Saskatchewan SK 47
Yukon 'Yukon YT 60

! Source: Statistics Canada, Standard Geographical Classification (SGC) 2001

2 Source: Canada Post Corporation, The Canadian Addressing Guide, October 2002
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Appendix C: Canadian Urban Areas and Abbreviations

Canadian urban areas are based upon DMTI’s topographic coverage areas. The following table is a
partial list of urban areas and their abbreviations. For a complete listing of Canadian urban areas refer to
the CANtop file located in the Canada Directory or for information regarding other areas contact DMTI
Spatial.

Province Topographic Coverage Area Abbreviation
AB Calgary CLGRY
IAB Edmonton EDMNT
BC \Vancouver VNCVR
BC Victoria VCTRA
MB Winnipeg WINPG
NB Fredericton FRDTN
NB Saint John STJON
NL Labrador City LBDRC
NL St. John's STJHN
NS Halifax HALFX
NT Y ellowknife YLKNF
NU Igaluit IQALT
ON Greater Toronto Area GTA
ON Hamilton Niagara HAMNG
ON Ottawa OTAWA
PE Charlottetown CHLTN
QC Hull HULL
QC Montreal MNTRL
QC Quebec City QBCTY
SK Regina RGNA
YT Whitehorse WTHRS
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Appendix D: Standard Industrial Classification Codes

What is an SIC Code?

Standard Industrial Classification (SIC) codes are four digit* numerical codes that were established in
1987 by the U.S. Government. The codes were assigned to businesses to group and identify their
primary area of business activity and to facilitate the collection of economic data for statistical analysis by
federal, state, and private organizations. The SIC code classifications cover all economic related
activities including agriculture, forestry & fishing; mining; construction; manufacturing; transportation,
communications, electric, gas, and sanitary services; wholesale trade; retail trade; finance, insurance,
real estate; health, education, recreation and other services; and public administration.

* To accommodate for future changes to the SIC code DMTI has adopted a policy of representing the
code with eight (8) characters. The four zeroes at the end of the code are a temporary space holder.

SIC Division

SIC Division is represented by a single letter, for example Division G refers to Retail Trade. Each Division
represents a broad area of economic activity:

Division |Description SIC Range
A Agriculture, Forestry, And Fishing 01 to 09
B Mining 10to 14
C Construction 15to0 17
D Manufacturing 20 to 39
E Transportation, Communications, Electric, Gas, And Sanitary Services 40 to 49
F \Wholesale Trade 50 to 51
G Retail Trade 52 to 59
H Finance, Insurance, And Real Estate 60 to 67
I Services 70 to 88
J Public Administration 90 to 99
K Unclassified 00

SIC Major Group

SIC Major Group represents the first two digits of the code for example, Major Group 80 refers to Health
Services. Each Major Group represents a sector or industry group:

Major Group

Description

SIC Range

01

Agricultural Production Crops

0111 to 0191

02 Agricultural Production Livestock And Animal Specialties 0211 to 0291
07 Agricultural Services 0711 to 0783
08 Forestry 0811 to 0851
09 Fishing, Hunting, And Trapping 0911 to 0971
10 Metal Mining 1011 to 1099
12 Coal Mining 1221 to 1241
13 Oil And Gas Extraction 1311 to 1389
14 Mining And Quarrying Of Nonmetallic Minerals, Except Fuels 1411 to 1499
15 Building Construction General Contractors And Operative Builders 1521 to 1542
16 Heavy Construction Other Than Building Construction Contractors 1611 to 1629
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Major Group

Description

SIC Range

17

Construction Special Trade Contractors

1711to 1799

20 Food And Kindred Products 2011 to 2099
21 [Tobacco Products 2111 to 2141
22 [Textile Mill Products 2211 to 2299
Apparel And Other Finished Products Made From Fabrics And Similar
23 Materials 2311 to 2399
24 Lumber And Wood Products, Except Furniture 2411 to 2499
25 Furniture And Fixtures 2511 to 2599
26 Paper And Allied Products 2611 to 2679
27 Printing, Publishing, And Allied Industries 2711 to 2796
28 Chemicals And Allied Products 2812 to 2899
29 Petroleum Refining And Related Industries 2911 to 2999
30 Rubber And Miscellaneous Plastics Products 3011 to 3089
31 Leather And Leather Products 3111 to 3199
32 Stone, Clay, Glass, And Concrete Products 3211 to 3299
33 Primary Metal Industries 3312 to 3399
Fabricated Metal Products, Except Machinery And Transportation
34 Equipment 3411 to 3499
35 Industrial And Commercial Machinery And Computer Equipment 3511 to 3599
Electronic And Other Electrical Equipment And Components, Except
36 Computer Equipment 3612 to 3699
37 [Transportation Equipment 3711 to 3799
Measuring, Analyzing, And Controlling Instruments; Photographic,
38 Medical And Optical Goods; Watches And Clocks 3812 to 3873
39 Miscellaneous Manufacturing Industries 3911 to 3999
40 Major Group 40: Railroad Transportation 4011 to 4013
Local And Suburban Transit And Interurban Highway Passenger
41 [Transportation 4111 to 4173
42 Motor Freight Transportation And Warehousing 4212 to 4231
43 United States Postal Service 4311 to 4311
44 \Water Transportation 4412 to 4499
45 [Transportation By Air 4512 to 4581
46 Pipelines, Except Natural Gas 4612 to 4619
a7 [Transportation Services 4724 to 4789
48 Communications 4812 to 4899
49 Electric, Gas, And Sanitary Services 4911 to 4971
50 \Wholesale Trade-durable Goods 5012 to 5099
51 \Wholesale Trade-non-durable Goods 5111 to 5199
Building Materials, Hardware, Garden Supply, And Mobile Home
52 Dealers 5211 to 5271
53 General Merchandise Stores 5311 to 5399
54 Food Stores 5411 to 5499
55 Automotive Dealers And Gasoline Service Stations 5511 to 5599
56 Apparel And Accessory Stores 5611 to 5699
57 Home Furniture, Furnishings, And Equipment Stores 5712 to 5736
58 Eating And Drinking Places 5812 to 5813
59 Miscellaneous Retail 5912 to 5999
60 Depository Institutions 6011 to 6099
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Major Group

Description

SIC Range

61

Non-depository Credit Institutions

6111 to 6163

62 Security And Commaodity Brokers, Dealers, Exchanges, And Services 6211 to 6289
63 Insurance Carriers 6311 to 6399
64 Insurance Agents, Brokers, And Service 6411 to 6411
65 Real Estate 6512 to 6553
67 Holding And Other Investment Offices 6712 to 6799
70 Hotels, Rooming Houses, Camps, And Other Lodging Places 7011 to 7041
72 Personal Services 7211 to 7299
73 Business Services 7311 to 7389
75 Automotive Repair, Services, And Parking 7513 to 7549
76 Miscellaneous Repair Services 7622 to 7699
78 Motion Pictures 7812 to 7841
79 Amusement And Recreation Services 7911 to 7999
80 Health Services 8011 to 8099
81 Legal Services 8111 to 8111
82 Educational Services 8211 to 8299
83 Social Services 8322 to 8399
84 Museums, Art Galleries, And Botanical And Zoological Gardens 8412 to 8422
86 Membership Organizations 8611 to 8699
Engineering, Accounting, Research, Management, And Related
87 Services 8711 to 8748
38 Private Households 8811 to 8811
91 Executive, Legislative, And General Government, Except Finance 9111 to 9199
92 Justice, Public Order, And Safety 9111 to 9229
93 Public Finance, Taxation, And Monetary Policy 0311 to 9311
94 IAdministration Of Human Resource Programs 9411 to 9451
95 Administration Of Environmental Quality And Housing Programs 9511 to 9532
96 Administration Of Economic Programs 9611 to 9661
97 National Security And International Affairs 9711 to 9721
99 No classifiable Establishments 9999 to 9999
00 Unclassified 0000 to 0000
SIC Code

SIC Code represents the four digits of the code, for example SIC Code 5431 refers to Fruit and Vegetable

Markets. Each SIC Code represents specific products or services for a business:

SIC Code | Description of SIC Code

0134 Irish Potatoes

0161 Vegetables And Melons

0171 Berry Crops

0175 Deciduous Tree Fruits

0181 Ornamental Floriculture And Nursery Products
0182 Food Crops Grown Under Cover
0191 General Farms Primarily Crop
0211 Beef Cattle Feedlots

0212 Beef Cattle Except Feedlots
0219 General Livestock Nec
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SIC Code | Description of SIC Code

0254 Poultry Hatcheries

0259 Poultry And Eggs Nec

0271 Fur-bearing Animals And Rabbits

0272 Horses And Other Equines

0273 Animal Aquaculture

0279 Animal Specialties Nec

0721 Crop Planting And Protection

0723 Crop Preparation Services For Market

0742 Veterinary Services For Animal Specialties

0751 Livestock Services Exc. Veterinary

0752 Animal Specialty Services

0761 Farm Labor Contractors

0762 Farm Management Services

0781 Landscape Counseling And Planning

0782 Lawn And Garden Services

0783 Ornamental Shrub And Tree Services

0811 Timber Tracts

0831 Forest Nurseries And Gathering Of Forest Products

0851 Forestry Services

0912 Finfish

0913 Shellfish

0919 Miscellaneous Marine Products

0921 Fish Hatcheries And Preserves

0971 Hunting Trapping Game Propagation

1000 Mining

1011 Iron Ores

1041 Gold Ores

1081 Metal Mining Services

1221 Bituminous Coal And Lignite Surface Mining

1311 Crude Petroleum And Natural Gas

1381 Drilling Oil And Gas Wells

1382 Oil And Gas Exploration Services

1389 Oil And Gas Field Services Nec

1411 Dimension Stone

1422 Crushed And Broken Limestone

1423 Crushed And Broken Granite

1429 Crushed And Broken Stone Nec

1442 Construction Sand And Gravel

1499 Nonmetallic Minerals Nec

1521 Single-family Housing Construction

1541 Industrial Buildings And Warehouses

1542 Nonresidential Construction Nec

1611 Highway And Street Construction

1622 Bridge Tunnel And Elevated Highway

1623 Water Sewer And Utility Lines

1629 Heavy Construction Nec

1711 Plumbing Heating Air Conditioning
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SIC Code | Description of SIC Code

1721 Painting And Paper Hanging

1731 Electrical Work

1741 Masonry And Other Stonework

1742 Plastering Dry Wall And Insulation

1743 Terrazzo Tile Marble Mosaic Work

1751 Carpentry Work

1752 Floor Laying And Floor Work Nec

1761 Roofing Siding And Sheet Metal Work

1771 Concrete Work

1781 Water Well Drilling

1791 Structural Steel Erection

1793 Glass And Glazing Work

1794 Excavation Work

1795 Wrecking And Demolition Work

1796 Installing Building Equipment Nec

1799 Special Trade Contractors Nec

2011 Meat Packing Plants

2013 Sausages And Other Prepared Meats

2021 Creamery Butter

2022 Cheese Natural And Processed

2023 Dry Condensed And Evaporated Milk

2024 Ice Cream And Frozen Desserts

2026 Fluid Milk

2032 Canned Specialties

2033 Canned Fruits Vegetables Preserves Jams And Jellies

2034 Dehydrated Fruits Vegetables Soups

2035 Pickles Sauces And Salad Dressings

2037 Frozen Fruits Juices And Vegetables

2041 Flour And Other Grain Mill Products

2043 Cereal Breakfast Foods

2044 Rice Milling

2045 Blended And Prepared Flour

2046 Wet Corn Milling

2047 Dog And Cat Food

2048 Prepared Feeds Nec

2051 Bread Cake And Related Products

2052 Cookies And Crackers

2062 Cane Sugar Refining

2064 Candy And Other Confectionery Products

2066 Chocolate And Cocoa Products

2067 Chewing Gum

2075 Soybean QOil Mills

2077 Animal And Marine Fats And Oils

2079 Shortening And Cooking Oils

2082 Malt Beverages

2083 Malt

2084 Wines Brandy And Brandy Spirits
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2085 Distilled And Blended Liquors
2086 Bottled And Canned Soft Drinks
2087 Flavoring Extracts And Syrups Nec
2091 Canned And Cured Fish And Seafoods
2092 Fresh Or Frozen Packaged Fish
2096 Potato Chips Corn Chips And Similar Snacks
2097 Manufactured Ice
2099 Food Preparations Nec
2111 Cigarettes
2211 Weaving Mills Cotton
2221 Weaving Mills Synthetic Fibres
2231 Weaving And Finishing Mills Wool
2241 Narrow Fabric Mills
2251 Women's Hosiery Except Socks
2253 Knit Outerwear Mills
2257 Circular Knit Fabric Mills
2258 Warp Knit Fabric Mills
2269 Finishing Plants Nec
2273 Carpets And Rugs
2281 Yarn Spinning Mills
2295 Coated Fabrics Not Rubberized
2297 Nonwoven Fabrics
2298 Cordage And Twine
2299 Textile Goods Nec
2311 Men's And Boys' Suits And Coats
2321 Men's And Boys' Shirts
2322 Men's And Boys' Underwear And Nightwear
2323 Men's And Boys' Neckwear
2325 Men's And Boys' Separate Trousers
2326 Men's And Boys' Work Clothing
2329 Men's And Boys' Clothing Nec
2331 Women's And Misses' Blouses And Waists
2335 Women's And Misses' Dresses
2337 Women's And Misses' Suits And Coats
2339 Women's And Misses' Outerwear Nec
2341 Women's And Children's Underwear And Nightwear
2342 Brassieres And Allied Garments
2353 Hats Caps And Millinery
2361 Girls' And Children's Dresses And Blouses
2371 Fur Goods
2381 Fabric Dress And Work Gloves
2385 Waterproof Outerwear
2386 Leather And Sheep Lined Clothing
2387 Apparel Belts
2389 Apparel And Accessories Nec
2391 Curtains And Draperies
2392 House Furnishings Nec
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2393 Textile Bags

2394 Canvas And Related Products

2395 Pleating And Stitching

2396 Automotive And Apparel Trimmings

2399 Fabricated Textile Products Nec

2411 Logging

2421 Sawmills And Planing Mills General

2426 Hardwood Dimension And Flooring

2429 Special Product Sawmills Nec

2431 Millwork

2435 Hardwood Veneer And Plywood

2439 Structural Wood Members Nec

2441 Nailed Wood Boxes And Shook

2448 Wood Pallets And Skids

2451 Mobile Homes

2452 Prefabricated Wood Buildings

2491 Wood Preserving

2493 Reconstituted Wood Products

2499 Wood Products Nec

2511 Wood Household Furniture

2515 Mattresses Foundations And Convertible Beds

2522 Metal Office Furniture

2531 Public Building And Related Furniture

2541 Wood Partitions And Fixtures

2542 Metal Partitions And Fixtures

2591 Drapery Hardware And Blinds And Shades

2599 Furniture And Fixtures Nec

2611 Pulp Mills

2621 Paper Mills

2631 Paperboard Mills

2652 Set-up Paperboard Boxes

2653 Corrugated And Solid Fiber Boxes

2655 Fiber Cans Drums And Similar Products

2657 Folding Paperboard Boxes

2672 Coated And Laminated Paper Nec

2673 Plastics Foil And Coated Paper Bags

2674 Uncoated Paper And Multiwall Bags

2676 Sanitary Paper Products

2677 Envelopes

2678 Stationery Tablets And Related Products

2679 Converted Paper And Paperboard Products Nec

2711 Newspapers

2721 Periodicals

2731 Book Publishing

2741 Miscellaneous Publishing

2752 Commercial Printing Lithographic

2754 Commercial Printing Gravure
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2759 Commercial Printing Nec

2761 Manifold Business Forms

2771 Greeting Cards

2782 Blankbooks And Looseleaf Binders
2789 Bookbinding And Related Work

2791 Typesetting

2796 Platemaking And Related Services
2812 Alkalies And Chlorine

2813 Industrial Gases

2816 Inorganic Pigments

2819 Industrial Inorganic Chemicals Nec
2821 Plastics Materials And Resins

2822 Synthetic Rubber

2833 Medicinal Chemicals And Botanical Products
2834 Pharmaceutical Preparations

2842 Polishes And Sanitation Goods

2844 Toilet Preparations

2851 Paints And Allied Products

2861 Gum And Wood Chemicals

2865 Cyclic Crudes And Intermediates
2869 Industrial Organic Chemicals Nec
2873 Nitrogenous Fertilizers

2879 Pesticides And Agricultural Chemicals Nec
2891 Adhesives And Sealants

2892 Explosives

2893 Printing Ink

2899 Chemical Preparations Nec

2911 Petroleum Refining

2951 Asphalt Paving Mixtures And Blocks
2992 Lubricating Oils And Greases

2999 Petroleum And Coal Products Nec
3011 Tires And Inner Tubes

3021 Rubber And Plastics Footwear

3052 Rubber And Plastic Hose And Belting
3053 Gaskets Packing And Sealing Devices
3061 Molded Extruded And Lathe-Cut Mechanical Rubber Products
3069 Fabricated Rubber Products Nec
3081 Unsupported Plastics Film And Sheet
3083 Laminated Plastics Plate Sheet And Profile Shapes
3084 Plastics Pipe

3086 Plastics Foam Products

3088 Plastics Plumbing Fixtures

3089 Plastics Products Nec

3111 Leather Tanning And Finishing

3131 Footwear Cut Stock

3161 Luggage

3171 Women's Handbags And Purses
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3172 Personal Leather Goods Nec

3199 Leather Goods Nec

3221 Glass Containers

3229 Pressed And Blown Glass Nec

3231 Products Of Purchased Glass

3241 Cement Hydraulic

3253 Ceramic Wall And Floor Tile

3255 Clay Refractories

3262 Vitreous China Table And Kitchen Articles

3269 Pottery Products Nec

3271 Concrete Block And Brick

3272 Concrete Products Nec

3273 Ready-mixed Concrete

3275 Gypsum Products

3281 Cut Stone And Stone Products

3291 Abrasive Products

3292 Asbestos Products

3296 Mineral Wool

3299 Nonmetallic Mineral Products Nec

3312 Blast Furnaces And Steel Mills

3315 Steel Wire And Related Products

3316 Cold Finishing Of Steel Shapes

3317 Steel Pipe And Tubes

3321 Gray Iron Foundries

3324 Steel Investment Foundries

3325 Steel Foundries Nec

3331 Primary Copper

3334 Primary Aluminum

3339 Primary Nonferrous Metals Nec

3341 Secondary Smelting And Refining Of Nonferrous Metals

3351 Copper Rolling And Drawing

3353 Aluminum Sheet Plate And Foll

3355 Aluminum Rolling And Drawing Nec

3356 Nonferrous Rolling And Drawing Nec

3364 Nonferrous Die-Castings Except Aluminum

3398 Metal Heat Treating

3399 Primary Metal Products Nec

3411 Metal Cans

3412 Metal Barrels Drums And Pails

3421 Cutlery

3423 Hand And Edge Tools Nec

3429 Hardware Nec

3431 Metal Sanitary Ware

3432 Plumbing Fittings And Brass Goods

3433 Heating Equipment Except Electric

3441 Fabricated Structural Metal

3442 Metal Doors Sash And Trim
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3443 Fabricated Plate Work (Boiler Shops)

3444 Sheet Metal Work

3446 Architectural Metal Work

3448 Prefabricated Metal Buildings

3449 Miscellaneous Metal Work

3451 Screw Machine Products

3452 Bolts Nuts Rivets And Washers

3462 Iron And Steel Forgings

3463 Nonferrous Forgings

3466 Crowns And Closures

3469 Metal Stampings Nec

3471 Plating And Polishing

3479 Coating Engraving And Allied Services

3484 Small Arms

3491 Industrial Valves

3492 Fluid Power Valves And Hose Fittings

3494 Valves And Pipe Fittings Nec

3495 Wire Springs

3496 Misc. Fabricated Wire Products

3498 Fabricated Pipe And Fittings

3499 Fabricated Metal Products Nec

3511 Turbines And Turbine Generator Sets

3519 Internal Combustion Engines Nec

3523 Farm Machinery And Equipment

3531 Construction Machinery

3533 Oil And Gas Field Machinery

3535 Conveyors And Conveying Equipment

3536 Hoists Cranes And Monorails

3537 Industrial Trucks And Tractors

3541 Machine Tools Metal Cutting Types

3542 Machine Tools Metal Forming Types

3543 Industrial Patterns

3544 Special Dies Tools Jigs And Fixtures

3545 Machine Tool Accessories

3546 Power Driven Hand Tools

3548 Welding Equipment

3549 Metalworking Machinery Nec

3552 Textile Machinery

3553 Woodworking Machinery

3554 Paper Industries Machinery

3555 Printing Trades Machinery

3556 Food Products Machinery

3559 Special Industry Machinery Nec

3564 Blowers And Fans

3565 Packaging Machinery

3566 Speed Changers Drives And Gears

3567 Industrial Furnaces And Ovens
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3568 Power Transmission Equipment Nec

3569 General Industrial Machinery Nec

3571 Electronic Computers

3577 Computer Peripheral Equipment Nec

3579 Office Machines Nec

3581 Automatic Vending Machines

3582 Commercial Laundry Equipment

3585 Refrigeration And Heating Equipment

3589 Service Industry Machinery Nec

3599 Machinery Except Electrical Nec

3612 Transformers

3613 Switchgear And Switchboard Apparatus

3621 Motors And Generators

3624 Carbon And Graphite Products

3625 Relays And Industrial Controls

3629 Electrical Industrial Apparatus Nec

3631 Household Cooking Equipment

3632 Household Refrigerators And Freezers

3633 Household Laundry Equipment

3634 Electric Housewares And Fans

3635 Household Vacuum Cleaners

3639 Household Appliances Nec

3641 Electric Lamps Bulbs And Tubes

3643 Current-carrying Wiring Devices

3644 Noncurrent-carrying Wiring Devices

3645 Residential Lighting Fixtures

3646 Commercial Lighting Fixtures

3648 Lighting Equipment Nec

3652 Phonograph Records And Prerecorded Audio Tapes And Disks

3661 Telephone And Telegraph Apparatus

3663 Radio And TV Broadcasting Equipment

3669 Communications Equipment Nec

3672 Printed Circuit Boards

3674 Semiconductors And Related Devices

3675 Electronic Capacitors

3676 Electronic Resistors

3679 Electronic Components Nec

3694 Engine Electrical Equipment

3695 Magnetic And Optical Recording Media

3699 Electrical Equipment And Supplies Nec

3711 Motor Vehicles And Car Bodies

3713 Truck And Bus Bodies

3714 Motor Vehicle Parts And Accessories

3715 Truck Trailers

3721 Aircraft

3724 Aircraft Engines And Engine Parts

3728 Aircraft Equipment Nec
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3731 Ship Building And Repairing

3732 Boat Building And Repairing

3743 Railroad Equipment

3751 Motorcycles Bicycles And Parts

3769 Space Vehicle Equipment Nec

3792 Travel Trailers And Campers

3799 Transportation Equipment Nec

3812 Search And Navigation Equipment

3822 Environmental Controls

3823 Process Control Instruments

3824 Fluid Meters And Counting Devices

3825 Instruments To Measure Electricity

3827 Optical Instruments And Lenses

3829 Measuring And Controlling Devices Nec

3842 Surgical Appliances And Supplies

3844 X-Ray Apparatus And Tubes

3845 Electromedical Apparatus

3851 Ophthalmic Goods

3861 Photographic Equipment And Supplies

3873 Watches Clocks And Watchcases

3911 Jewelry Precious Metal

3914 Silverware and Plated Ware

3915 Jewelers' Materials And Lapidary Work

3931 Musical Instruments

3944 Games Toys And Children's Vehicles

3949 Sporting And Athletic Goods Nec

3951 Pens And Mechanical Pencils

3953 Marking Devices

3961 Costume Jewelry

3965 Fasteners Buttons Needles And Pins

3991 Brooms And Brushes

3993 Signs And Advertising Displays

3995 Burial Caskets

3996 Hard Surface Floor Coverings

3999 Manufacturing Industries Nec

4011 Railroads Line-haul Operating

4111 Local And Suburban Transit

4119 Local Passenger Transportation Nec

4121 Taxicabs

4131 Intercity Highway Transportation

4142 Charter Service Except Local

4212 Local Trucking Without Storage

4213 Trucking Except Local

4214 Local Trucking And Storage

4215 Courier Services Except By Air

4221 Farm Product Warehousing And Storage

4222 Refrigerated Warehousing
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4225 General Warehousing And Storage

4226 Special Warehousing And Storage Nec

4311 Canadian Postal Service

4412 Deep Sea Foreign Transportation Of Freight

4449 Water Transportation Of Freight Nec

4482 Ferries

4489 Water Transportation Of Passengers Nec

4491 Marine Cargo Handling

4492 Towing and Tugboat Services

4493 Marinas

4499 Water Transportation Services Nec

4512 Air Transportation Scheduled

4513 Air Courier Services

4522 Air Transportation Nonscheduled

4581 Airports Flying Fields And Airport Terminal Services

4619 Pipelines Nec

4724 Travel Agencies

4725 Tour Operators

4729 Arrangement Of Passenger Transportation Nec

4731 Arrangement Of Transportation Of Freight And Cargo

4741 Rental Of Railroad Cars

4783 Packing And Crating

4785 Inspection And Weighing Services For Motor Vehicles

4812 Radiotelephone Communications

4813 Telephone Communications Except Radiotelephone

4822 Telegraph And Other Message Communications

4832 Radio Broadcasting

4833 Television Broadcasting

4841 Cable And Other Pay Television Services

4899 Communications Services Nec

4911 Electric Services

4925 Gas Production And/Or Distribution

4941 Water Supply

4953 Refuse Systems

4959 Sanitary Services Nec

4961 Steam Supply

5012 Automobiles And Other Motor Vehicles

5013 Automotive Parts And Supplies

5014 Tires And Tubes

5015 Motor Vehicles Parts Used

5021 Furniture

5023 Home Furnishings

5031 Lumber Plywood And Millwork

5032 Brick Stone And Related Construction Materials

5033 Roofing Siding And Insulation Materials

5039 Construction Materials Nec

5043 Photographic Equipment And Supplies
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5044 Office Equipment

5045 Computer Equipment And Software

5046 Commercial Equipment Nec

5047 Medical Dental And Hospital Equipment And Supplies
5048 Ophthalmic Goods

5049 Professional Equipment Nec

5051 Metals Service Centers And Offices

5052 Coal And Other Minerals And Ores

5063 Electrical Apparatus And Equipment

5064 Electrical Appliances TV And Radios

5065 Electronic Parts And Equipment

5072 Hardware

5074 Plumbing And Hydronic Heating Supplies
5075 Warm Air Heating And Air Conditioning

5078 Refrigeration Equipment And Supplies

5082 Construction And Mining Machinery

5083 Farm And Garden Machinery And Equipment
5084 Industrial Machinery And Equipment

5085 Industrial Supplies

5087 Service Establishment Equipment And Supplies
5088 Transportation Equipment And Supplies
5091 Sporting And Recreational Goods And Supplies
5092 Toys And Hobby Goods And Supplies

5093 Scrap And Waste Materials

5094 Jewelry Watches And Precious Stones

5099 Durable Goods Nec

5111 Printing And Writing Paper

5112 Stationery And Office Supplies

5113 Industrial And Personal Service Paper

5122 Drugs Proprietaries And Sundries

5131 Piece Goods Notions And Other Dry Goods
5137 Women's And Children's Clothing

5139 Footwear

5141 Groceries General Line

5142 Packaged Frozen Foods

5143 Dairy Products

5144 Poultry And Poultry Products

5145 Confectionery

5146 Fish And Seafoods

5147 Meats And Meat Products

5148 Fresh Fruits and Vegetables

5149 Groceries And Related Products Nec

5153 Grain And Field Beans

5154 Livestock

5159 Farm-product Raw Materials Nec

5162 Plastics Materials And Basic Forms And Shapes
5169 Chemicals And Allied Products Nec
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5172 Petroleum Products Nec

5182 Wines And Distilled Beverages

5191 Farm Supplies

5192 Books Periodicals And Newspapers

5193 Flowers Nursery Stock And Florists' Supplies

5194 Tobacco And Tobacco Products

5199 Nondurable Goods Nec

5211 Lumber And Other Building Materials

5231 Paint Glass And Wallpaper Stores

5251 Hardware Stores

5261 Retail Nurseries And Garden Stores

5271 Mobile Home Dealers

5311 Department Stores

5331 Variety Stores

5399 Misc. General Merchandise Stores

5411 Grocery Stores

5421 Meat And Fish Markets

5431 Fruit And Vegetable Markets

5441 Candy Nut And Confectionery Stores

5451 Dairy Products Stores

5461 Retail Bakeries

5499 Miscellaneous Food Stores

5511 New Car Dealers

5521 Used Car Dealers

5531 Auto And Home Supply Stores

5541 Gasoline Service Stations

5541 Gasoline Service Stations

5551 Boat Dealers

5561 Recreational Vehicles Dealers

5571 Motorcycle Dealers

5599 Automotive Dealers Nec

5611 Men's And Boys' Clothing And Furnishings

5621 Women's Clothing Stores

5632 Women's Accessory And Specialty Stores

5641 Children's And Infants' Wear Stores

5651 Family Clothing Stores

5661 Shoe Stores

5699 Miscellaneous Apparel And Accessories

5712 Furniture Stores

5713 Floor Covering Stores

5714 Drapery And Upholstery Stores

5719 Misc. Home Furnishings Stores

5722 Household Appliance Stores

5731 Radio Television And Consumer Electronics Stores

5734 Computer And Computer Software Stores

5735 Record And Pre Recorded Tape Stores

5736 Musical Instrument Stores
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5812 Eating Places

5813 Drinking Places

5912 Drug Stores And Proprietary Stores

5921 Liquor Stores

5932 Used Merchandise Stores

5941 Sporting Goods And Bicycle Shops

5942 Book Stores

5943 Stationery Stores

5944 Jewelry Stores

5945 Hobby Toy And Game Shops

5946 Camera And Photographic Supply Stores

5947 Gift Novelty And Souvenir Shops

5948 Luggage And Leather Goods Stores

5949 Sewing Needlework And Piece Goods

5961 Catalog And Mail Order Houses

5962 Automatic Merchandising Machine Operators

5963 Direct Selling Organizations

5984 Liguefied Petroleum Gas Dealers

5989 Fuel Dealers Nec

5992 Florists

5993 Tobacco Stores And Stands

5994 News Dealers And Newsstands

5995 Optical Goods Stores

5999 Miscellaneous Retail Stores Nec

6011 Federal Reserve Banks

6021 National Commercial Banks

6022 State Commercial Banks

6061 Credit Unions Federally Chartered

6062 Credit Unions Not Federally Chartered

6099 Functions Related To Depository Banking Nec

6141 Personal Credit Institutions

6153 Short-term Business Credit

6159 Misc. Business Credit Institutions

6162 Mortgage Bankers And Correspondents

6211 Security Brokers And Dealers

6221 Commodity Contracts Brokers Dealers

6231 Security And Commaodity Exchanges

6282 Investment Advice

6289 Services Allied With The Exchange Of Securities Or Commodities Nec

6311 Life Insurance

6324 Hospital And Medical Service Plans

6331 Fire Marine And Casualty Insurance

6351 Surety Insurance

6371 Pension Health And Welfare Funds

6399 Insurance Carriers Nec

6411 Insurance Agents Brokers And Service

6512 Nonresidential Building Operators
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6513 Apartment Building Operators

6515 Mobile Home Site Operators

6531 Real Estate Agents And Managers

6541 Title Abstract Offices

6552 Land Subdividers And Developers Except Cemeteries

6553 Cemetery Subdividers And Developers

6719 Holding Companies Nec

6732 Educational Religious Etc. Trusts

6733 Trusts Nec

6792 Oil Royalty Traders

6794 Patent Owners And Lessors

6798 Real Estate Investment Trusts

6799 Investors Nec

7011 Hotels And Motels

7021 Rooming And Boarding Houses

7032 Sporting And Recreational Camps

7033 Recreational Vehicle Parks And Campsites

7200 Personal Services

7211 Power Laundries Family And Commercial

7212 Garment Pressing And Cleaners' Agents

7213 Linen Supply

7215 Coin-operated Laundries And Cleaning

7216 Dry Cleaning Plants Except Rug

7217 Carpet And Upholstery Cleaning

7219 Laundry And Garment Services Nec

7221 Photographic Studios Portrait

7231 Beauty Shops

7241 Barber Shops

7251 Shoe Repair Shops And Shoeshine Parlors

7261 Funeral Service And Crematories

7291 Tax Return Preparation Service

7299 Miscellaneous Personal Services Nec

7311 Advertising Agencies

7312 Outdoor Advertising Services

7313 Radio TV Publisher Representatives

7319 Advertising Nec

7322 Adjustment And Collection Services

7323 Credit Reporting Services

7331 Direct Mail Advertising Services

7334 Photocopying And Duplicating Service

7335 Commercial Photography

7336 Commercial Art And Graphic Design

7338 Secretarial And Court Reporting Services

7342 Disinfecting And Pest Control Services

7349 Building Maintenance Services Nec

7352 Medical Equipment Rental And Leasing

7353 Heavy Construction Equipment Rental And Leasing
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7359 Equipment Rental And Leasing Nec

7361 Employment Agencies

7363 Help Supply Services

7371 Computer Programming Services

7372 Computer Programming And Software
7373 Computer Integrated Systems Design
7374 Data Processing Services

7375 Information Retrieval Services

7376 Computer Facilities Management Services
7377 Computer Rental And Leasing

7378 Computer Maintenance And Repair

7379 Computer Related Services Nec

7381 Detective Guard And Armored Car Service
7382 Security Systems Services

7383 News Syndicates

7384 Photofinishing Laboratories

7389 Business Services Nec

7513 Truck Rental And Leasing Without Drivers
7514 Passenger Car Rental

7515 Passenger Car Leasing

7519 Recreation Vehicle And Trailer Rental
7521 Automobile Parking

7532 Top Body Upholstery Repair Shops And Paint Shops
7533 Automotive Exhaust System Repair Shops
7534 Tire Retreading And Repair Shops

7536 Automotive Glass Replacement Shops
7537 Automotive Transmission Repair Shops
7538 General Automotive Repair Shops

7539 Automotive Repair Shops Nec

7542 Car Washes

7549 Automotive Services Nec

7622 Radio And Television Repair

7623 Refrigeration Service And Repair

7629 Electrical Repair Shops Nec

7631 Watch Clock And Jewelry Repair

7641 Reupholstery And Furniture Repair

7692 Welding Repair

7694 Armature Rewinding Shops

7699 Repair Services Nec

7812 Motion Picture And Video Tape Production
7819 Services Allied To Motion Picture Production
7822 Motion Picture And Video Tape Distribution
7832 Motion Picture Theaters Ex Drive-in

7833 Drive-in Motion Picture Theaters

7841 Video Tape Rental

7911 Dance Studios Schools And Halls

7922 Theatrical Producers And Services
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7929 Entertainers And Entertainment Groups

7933 Bowling Centers

7941 Professional Sports Clubs And Promoters

7948 Racing Including Track Operation

7991 Physical Fitness Facilities

7992 Public Golf Courses

7993 Coin-operated Amusement Devices

7997 Membership Sports And Recreation Clubs

7999 Amusement And Recreation Nec

8011 Offices And Clinics Of Physicians

8021 Offices And Clinics Of Dentists

8031 Offices Of Osteopathic Physicians

8041 Offices Of Chiropractors

8042 Offices Of Optometrists

8043 Offices Of Podiatrists

8049 Offices Of Health Practitioners Nec

8059 Nursing And Personal Care Nec

8062 General Medical And Surgical Hospitals

8063 Psychiatric Hospitals

8069 Specialty Hospitals Exc Psychiatric

8071 Medical Laboratories

8072 Dental Laboratories

8082 Home Health Care Services

8093 Specialty Outpatient Facilities Nec

8099 Health And Allied Services Nec

8111 Legal Services

8211 Elementary And Secondary Schools

8221 Colleges And Universities

8231 Libraries

8243 Data Processing Schools

8244 Business And Secretarial Schools

8249 Vocational Schools Nec

8299 Schools And Educational Services Nec

8322 Individual And Family Social Services

8331 Job Training And Related Services

8331 Job Training and Vocational Rehabilitation Services

8351 Child Day Care Services

8361 Residential Care

8399 Social Services Nec

8412 Museums And Art Galleries

8422 Botanical And Zoological Gardens

8611 Business Associations

8621 Professional Organizations

8631 Labor Organizations

8641 Civic And Social Associations

8651 Political Organizations

8661 Religious Organizations
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8699 Membership Organizations Nec

8711 Engineering Services

8712 Architectural Services

8713 Surveying Services

8721 Accounting Auditing And Bookkeeping Services
8731 Commercial Physical And Biological Research
8732 Commercial Economic Sociological And Educational Research
8733 Non Commercial Research Organizations
8734 Testing Laboratories

8741 Management Services

8742 Management Consulting Services

8743 Public Relations Services

8748 Business Consulting Services Nec

8811 Private Households

8999 Services Nec

9111 Government Of Canada

9211 Government Of Newfoundland

9212 Government Of Prince Edward Island
9213 Government Of Nova Scotia

9214 Government Of New Brunswick

9221 Police Protection

9224 Government Of Québec

9235 Government Of Ontario

9246 Government Of Manitoba

9247 Government Of Saskatchewan

9248 Government Of Alberta

9259 Government Of British Columbia

9262 Government Of Northwest Territories
9263 Government Of Nunavut

9311 Municipalities And Urban Communities
9312 City Of Montréal

9721 International Affairs

9999 Unclassified
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Appendix E: Border Crossings and Customs Offices

More information regarding border crossings can be obtained from the www.ccra-adrc.gc.ca
(Memorandum D-1-1-1, Locator Code: 233B) from Canada Customs and Revenue Agency (CCRA).

The following information is sourced directly from the CCRA website and provides definitions and
explanations of the data contained in the Border Crossings and Customs (bor) look up table:

Explanation of Columns

2. The detailed office information is presented in an eight-column table that follows a standardized pattern
with some exceptions.

Port No. (Column 1)

3. The number in the first column of the table indicates the office number or port number as specified in
the Accelerated Commercial Release Operations Support System (ACROSS). Offices that have a number
in the first column and nothing in the second column are independent offices, and they do not report
through any other office or location.

4. Locations that have a number in both the first and second column are subordinate offices that
generally process their transactions through another office. An Inland Alternate Service (IAS) site reports
to an independent office called a hub. Subordinate offices have their number in the first column and the
number and name of the office they report to in the second column.

Note: Transactions may be processed using either number, depending on local preferences.

5. Service sites such as sufferance warehouses and marinas usually do not have a distinct number.
They process all their transactions using an independent office number.

Reports to Office (Column 2)

6. This column presents the number and name of the independent office through which subordinate
offices or service sites process their transactions.

Customs Office (Column 3)

7. The third column contains the name, and where applicable, the address and telephone numbers of the
office or site. Customs offices and service sites include actual staffed customs offices, airports, vessel
clearance terminals, offices that are serviced by staff from another location, sufferance warehouses, and
CANPASS locations. Not all locations or facilities provide all services, and some facilities may be
restricted to certain types of traffic or classes of goods. Offices names followed by "IAS" indicate that they
have been designated as an area that is serviced through the Inland Alternate Service program.

Hierarchy of Offices and Sites

8. In general, each region is divided into an individual appendix and then sub-divided into districts within
that appendix. (Note: Southern Ontario has recently been reorganized as one region with three separate
divisions. For formatting purposes only, this document treats each division as if it were a separate region,
resulting in a separate appendix for Southern Ontario (Inland), Southern Ontario (Niagara/Fort Erie), and
Southern Ontario (Windsor/St. Clair)). Wherever possible, the primary or independent offices are listed in
numerical order with their subordinate offices and service sites listed immediately after them. As a result
of this, some subordinate offices may initially appear to be out of numerical order. However, they are
actually in their appropriate place under the primary or the hub through which they process their
transactions.
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9. Finally, a third level of sorting has been applied to the information provided in column 3. Having been
first grouped by the independent office number and then the subordinate office numbers in columns 1
and 2, the various offices and sites are prioritized according to the type of function or service they
provide.

10. The general categories are, in descending order:
(a) independent office and subordinate offices;

(b) airports;

(c) marine facilities;

(d) rail stations and depots;

(e) warehouses; and

() CANPASS service sites.

Hours of Service (Columns 4 and 5)

11. The hours of service indicate the hours that have been officially designated as the times when the
customs office is normally open for business. Locations that are listed as being open 24 hours per day,

7 days a week may not provide all services during the entire 24-hour period. For example, some offices
may provide full release and accounting services during the day shift, Monday to Friday, but may not
have full accounting services available during the evenings or weekends. Clients are encouraged to verify
hours of operation with their local offices. Requests for new or expanded services, or services outside the
normal business hours, may be subject to cost recovery or special service charges.

12. Further information about the authorized hours of service at customs offices may be obtained by
referring to Memorandum D1-2-1, Special Services.

Services (Column 6)

13. The symbols shown in column 6 indicate the specific services or activities available at the customs
office or service site. The definitions are not necessarily all-inclusive and should be used as a guide only.

HWY - Land and Inland Border Office - authorized port of entry at which passenger, general public,
or commercial highway traffic is permitted to report. Land borders include both CANADA/U.S. border
crossing points and inland border points.

EDI - Electronic Data Interchange - the transmission, transfer, interchange, or electronic release of
accounting data.

IAS - Inland Alternate Service - the provision of release services to inland locations from a hub.
COMMERCIAL - Designated Commercial Office - offices that provide commercial service free from
the imposition of any special service charges on a 7 day/24 hour basis.

IMM - Immigration - an immigration officer is on site.

NTO - Non-Terminal Office - office is not equipped with a computer communication system.

POST - International Mail Centre - office at which the processing of international mail or the control
of outstanding postal accounts occurs.

AERO-INTL - International Airport - authorized customs airport of entry and exit for clearance of all
classes of air traffic (Airport of Entry Designator Code AOE-A - see Memorandum D2-5-1, Charter
Access to Airports).

AERO-REG - Regional Airport - authorized customs airport of entry and exit for clearance of
commercial air traffic carrying freight or a passenger load not exceeding the capacity limits specified
(Airport of Entry Designator Code AOE-R or AOE-RA - see Memorandum D2-5-1).

AERO-GEN - General Aviation Airport - authorized customs airport of entry and exit for general
aviation air traffic, i.e., privately operated or small charter aircraft carrying no more than

15 passengers and their baggage (Airport of Entry Designator Code AOE-X or AOE-XA - see
Memorandum D2-5-1).

SeaPl - Sea Plane Landing Site - authorized point of entry for sea planes.
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C-Ves - Commercial Vessel Clearing Station - locations at which commercial vessels are permitted
to report.

P-Ves - Private or Non-Commercial Vessel Reporting Station - locations at which non-commercial
vessels (pleasure crafts) are permitted to report.

FERRY - Ferry Terminal - terminal where passengers and vehicles embark or disembark from a
ferry.

CSO - Cruise Ship Operations - authorized debarkation site for cruise ship passengers and crew.
RAIL - Railway Depot - first point in Canada at which a passenger or freight train stops and
discharges passengers or goods.

SWH - Warehouse - highway sufferance warehouses or special bonded warehouses for perishable
goods.

Shop - Duty-Free Shop - a duty-free shop is located at the customs location. More specific duty-free
shop details can be obtained from Memorandum D4-3-2, Duty Free Shop - Licensing.

ACEEDO - locations at which acting Revenue Canada enforcement officers have been authorized.
CPO - Only the CANPASS programs are serviced at this location

CPA - CANPASS - Private and Corporate Aircraft

CPB - CANPASS - Private Boat

CPL - CANPASS - Voyageur

Note: All references to CANPASS programs, services, or sites refer to a CANPASS pilot project that was
being tested at the time this document was released.

Airport or Vessel Code (Column 7)

14. This column identifies the airport designator code, the passenger capacity limits per flight for
inspection services purposes, and the station responsible for flight plans. Further information regarding
services provided at airports can be obtained from Memorandum D3-2-1, International Air Traffic, and
Memorandum D2-5-1. Vessel registration office numbers are also included in this section.

Opposite U.S. Office (Column 8)

15. The U.S. customs office is opposite the Canadian customs office.
ADDITIONAL INFORMATION

16. All requests for revisions should be submitted to the following address:

Manager of Facilities and Services

Operational Policy and Coordination Directorate
Customs and Trade Administration Branch
Revenue Canada

15th floor

Sir Richard Scott Building

191 Laurier Avenue West

Ottawa ON K1A 0OL5

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
Not to be disclosed



© 2007 DMTI Spatial Inc. Page 46

Appendix F: Canadian Payments Association Classification

The Canadian Payments Association (CPA) developed a classification system, which divides the
institutions belonging to the payments associations into three groups:

1. Banks
2. Credit Unions and Caisses Populaires
3. Trust Companies, Loan Companies, and Other Deposit-Taking Institutions.

In conjunction with this classification system, the Financial Institution layer includes a field called
FIN_TYPE. The following is a listing of institution names, by their corresponding classification type, as
they appear in the FIN_TYPE field:

Banks

AMEX Bank of Canada Habib Canadian Bank

AMICUS Bank HSBC Bank Canada

Bank of America Canada ING Bank of Canada

Bank of Canada International Commercial Bank of Cathay
Bank of China Intesabci Canada

Bank of East Asia (Canada) JP Morgan Bank Canada

Bank of Montreal JP Morgan Chase Bank

Bank of Nova Scotia Korea Exchange Bank of Canada
Bank of Tokyo Mitsubishi (Canada) Manulife Bank of Canada

Bank One NA MBNA Canada Bank

Banque Laurentienne du Canada Mellon Bank Canada

Banque Nationale du Canada Mizuho Bank (Canada)

BNP Paribas (Canada) National Bank of Greece (Canada)
Canadian Imperial Bank of Commerce Paribas Bank of Canada
Canadian Western Bank Royal Bank of Canada

Capital One Bank (Canada Branch) Sakura Bank (Canada)

Cho Hung Bank of Canada Societe Generale (Canada)
Citibank Canada Sottomayor Bank Canada
Citibank, NA State Bank of India (Canada)
Citizens Bank of Canada Sumitoma Mitsui Banking Corporation of
Comerica Bank Canada

Credit Lyonnais Canada Tokai Bank Canada

Credit Suisse First Boston Canada Toronto-Dominion Bank, (The)

CS Alterna Bank UBS Bank Canada

CTC Bank of Canada UFJ Bank Canada

Deutsche Bank (Canada) United Overseas Bank (Canada)

Dresdner Bank Canada

Credit Unions and Caisses Populaires

Airline (Malton Credit Union)

Alltrans Credit Union

L'Alliance des caisses populaires de I'Ontario
Brunswick Credit Union Federation Ltd.
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CBC (Toronto) Credit Union Limited

Civil Service Co-op Credit Society

Co-operative Credit Society of Manitoba Limited
Communication Technologies CR UN Ltd

Confederation des caisses populaires et d’economie Desjardins du Quebec
Credit Union Central Alberta Ltd

Credit Union Central of British Columbia

Credit Union Central of Nova Scotia

Credit Union Central of Ontario Ltd

Credit Union Central of Saskatchewan

Duca Community Credit Union Ltd

Dundalk District Credit Union Ltd

Federation des Caisses Populaires Acadiennes Limitee, La
Federation des Caisses Populaires de I'Ontario Inc, La
Federation des Caisses Populaires du Manitoba Inc, La
The Fire Department Employees Credit Union Ltd
Goderich Community Credit Union Ltd

Latvian Credit Union Limited

North York Community Credit Union Limited

Ontario Civil Services Credit Union Limited

Polysar Lambton Credit Union Limited

St Stanislaus-St Casimir’'s Polish Parishes Credit Union Limited

Trust Companies, Loan Companies, and Other Deposit-Taking Institutions

AGF Trust Company Montreal Trust Company

Alberta Treasury Branches Municipal Savings & Loan Corporation, The
B2B Trust Municipal Trust Company, The

B.C. Community Financial Services Corporation National Trust Company

Canada Trust Company, The Peace Hills Trust Company

Citizens Trust Company Promutuel Capital Trust Company Inc
Clarica Trust Company, The Province of Ontario Savings Office
Effort Trust Company, The Royal Trust Company, The
Evangeline Savings & Mortgage Co Royal Trust Corporation of Canada
Family Trust Corporation Settlers Savings and Mortgage Corp
Fuji Bank Canada Sherbrooke Trust, Company
Granville Savings & Mortgage Corp Societe D’Epargne St Bernard, La
Home Savings and Loan Corporation Sun Life Financial Trust Inc
Household Trust Company TD Trust Company

International Trust Company Trimark Trust

Investors Group Trust Co. Ltd. Trust General du Canada

MRS Trust Company Trust General Inc

Mennonite Trust Ltd Trust La Laurentienne
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English Abbreviations and Definitions

AB
ACC
ACC

ACIIS

ADMIN
AE DIST
AIR
AMF
AMT
A&P
ARU

ATI
ATTF
AVE

BC

BLDG
BLVD
BNPP

BP DIST
BR

BSG DIST
BUR

CAL
CAS
C-BDIST
CBS
CCAPSD

CCB
CCIs

CCRA

CCs
CDIU
CDN
C&E
CEF
CE&T
CFC
CFDU
CFSEU

CHARLT'N
CiB

CIC

CID

Chu

CIR
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A

ALBERTA

ACCIDENT

ADMINISTRATION
COMMUNICATIONS CENTRE
AUTOMATED CRIMINAL
INTELLIGENCE

INFORMATION SYSTEM
ADMINISTRATION/ADMINISTRATIVE
AVALON EAST DISTRICT
AIRPORT

AIRPORT MAIL FACILITY

AREA MANAGEMENT TEAM
ADMINISTRATION & PERSONNEL
ALTERNATE RESPONSE UNIT
ACCESS TO INFORMATION
AUTO THEFT TASK FORCE
AVENUE

B

BRITISH COLUMBIA

BUILDING

BOULEVARD
BERESFORD/NIGADOO/PETIT-
ROCHER/POINTE-VERTE
BURIN PENINSULA DISTRICT
BRANCH

BAY ST GEORGE DISTRICT
BUREAU

C

CALGARY

CRIMINAL ANALYSIS SECTION
CLARENVILLE-BONAVISTA DISTRICT
CUSTOMS BORDER SERVICES
COMMUNITY, CONTRACT &
ABORIGINAL POLICING SERVICES
COMMERCIAL CRIME BRANCH
CALGARY CRIMINAL INTELLIGENCE
SECTION

CANADA CUSTOMS & REVENUE
AGENCY

COMMERCIAL CRIME SECTION
CENTRAL DRUG INFORMATION UNIT
CANADIAN

CUSTOMS & EXCISE

CONTAINER EXAMINATION FACILITY
CUSTOMS, EXCISE & TAXATION
CANADIAN FIREARMS CENTRE
COMBINED FORCES DRUG UNIT
COMBINED FORCES SPECIAL
ENFORCEMENT UNIT
CHARLOTTETOWN

CRIMINAL INVESTIGATION BRANCH
CITIZEN & IMMIGRATION CANADA
CRIMINAL INTELLIGENCE
DIRECTORATE

CALGARY INTEGRATED
INTELLIGENCE UNIT

CIRCLE

CIs

CISA

CISsBC

CisC

CISM

CISN

CISNB

CISNS

CISO

CISs

coB
COMCENTRE
COMM
COMP

CON

CONST
CO-ORD
CORRECT
CORRES
COs

CPC
CPIC
CPO
CPR
CPSIC
CR
CRS
CSAB
CSBC

CsC
CSsIS

CSMB

CSNB

CSON
CSSK
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CRIME INDEX SECTION/CRIMINAL
INVESTIGATION SECTION
CRIMINAL INTELLIGENCE SERVICE
ALBERTA

CRIMINAL INTELLIGENCE SERVICE
BRITISH COLUMBIA

CRIMINAL INTELLIGENCE SERVICE
CANADA

CRIMINAL INTELLIGENCE SERVICE
MANITOBA

CRIMINAL INTELLIGENCE SERVICE
NEWFOUNDLAND

CRIMINAL INTELLIGENCE SERVICE
NEW BRUNSWICK

CRIMINAL INTELLIGENCE SERVICE
NOVA SCOTIA

CRIMINAL INTELLIGENCE SERVICE
ONTARIO

CRIMINAL INTELLIGENCE SERVICE
SASKATCHEWAN

CRIMINAL INTELLIGENCE UNIT
CIVIL/CIVILIAN

CIVIL LITIGATION

CLASSIFICATION

COORDINATED LAW ENFORCEMENT
UNIT

CIVILIAN MEMBER

CRIMINAL NAME INDEX
COMMANDING OFFICER

COUNTY

CRIMINAL OPERATIONS BRANCH
COMMUNICATIONS CENTRE
COMMUNICATIONS/COMMUNITY
COMPARTMENT

CONTRACTS

CONSTABULARY
COORDINATOR/COORDINATION
CORRECTIONAL
CORRESPONDENCE

CRIMINAL ORGANIZATION
/OPERATIONS SECTION
CANADIAN POLICE COLLEGE/
CASE PROCESSING CENTRE
CANADIAN POLICE INFORMATION
CENTRE

CASE PRESENTATION OFFICER
CANADIAN PACIFIC RAILWAY
CANADIAN POLICE SERVICES
INFORMATION CENTRE
CRESCENT

CRIMINAL RECORDS SYNOPSIS
CORRECTIONAL SERVICE ALBERTA
CORRECTIONAL SERVICE BRITISH
COLUMBIA

CORRECTIONAL SERVICE CANADA
CANADIAN SECURITY
INTELLIGENCE SERVICE
CORRECTIONAL SERVICE
MANITOBA

CORRECTIONAL SERVICE NEW
BRUNSWICK

CORRECTIONAL SERVICE ONTARIO
CORRECTIONAL SERVICE
SASKATCHEWAN
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CST
CTR
CTY

D5
DCAS

DCAU

DCIAS

DEB
DEPT
DES
DET
DEOC

DEU
DHQ
DIFO

DIR
DIST
DIV

DL DIST
DND

DOAC
D&R
DSC

DSRR

ECD

ECON
EDT'N
EDPS

EEOC

E&l
EllU

ENF/ENFORCE
ERM

ERT
ESO
EST
ESU
EU
EXEC

FAC
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CONSTABLE
CENTRE
CITY

D

DISTRICT

DIVISION CRIMINAL ANALYSIS
SECTION

DIVISION CRIMINAL ANALYTICAL
UNIT

DIVISIONAL CRIMINAL INFORMATION
ANALYTICAL SECTION/DIVISION
CRIME INTELLIGENCE ANALYTICAL
SERVICE

DRUG ENFORCEMENT BRANCH
DEPARTMENT

DRUG ENFORCEMENT SECTION
DETACHMENT

DIVISION EMERGENCY OPS
COMCENTRE

DRUG ENFORCEMENT UNIT
DISTRICT HEADQUARTERS
DRUG INTELLIGENCE & FIELD
OPERATIONS
DIRECTOR/DIRECTORATE
DISTRICT

DIVISION

DEER LAKE DISTRICT
DEPARTMENT OF NATIONAL
DEFENCE

DANGEROUS OFFENDERS
APPLICATIONS CENTRE
DETENTION & REMOVALS
DRIVE

DIRECTORATE OF SECURITY
CLEARANCES

DIVISIONAL STAFF RELATIONS
REPRESENTATIVE

E

EAST

ECONOMIC CRIME DIRECTORATE
ECONOMIC

EDMONTON

EXECUTIVE DIPLOMATIC
PROTECTION
SECTION/ELECTRONIC DATA
PROCESSING SECTION

EAST EUROPEAN ORGANIZED
CRIME

ENFORCEMENT & INVESTIGATIONS
EDMONTON INTEGRATED
INTELLIGENCE UNIT
ENFORCEMENT

ENVIRONMENT & RESOURCE
MANAGEMENT

EMERGENCY RESPONSE TEAM
ENFORCEMENT SERVICES OFFICER
ESTABLISHMENT

ENFORCEMENT SUPPORT UNIT
ENFORCEMENT UNIT

EXECUTIVE

F

FIREARMS ACQUISITION
CERTIFICATE

FBI

FED
FES
FIC

FINGERPRT
FINTRAC

FIS

FIU
FLR
FLSD

FNCPS
FOSS

FOT

FPS
FREDT'N
FRY

FSD
F&SD
FSSB
BRANCH

GD
GF-W DIST
GHQ

GIS

GST

GTEC

HAL
HP

HQ

HRP

HTS

HV-GOOSE BAY
HWY

IAP
IIC, IC
1&C
ICBC
ICES
ICPB
ID
IDENT
IFB
IFSB
IIEU

s
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FEDERAL BUREAU OF
INVESTIGATION

FEDERAL

FEDERAL ENFORCEMENT SECTION
FINANCIAL INSTITUTIONS
COMMISSION

FINGERPRINT

FINANCIAL TRANSACTIONS AND
REPORTS ANALYSIS CENTRE OF
CANADA

FORENSIC IDENTIFICATION
SECTION

FEDERAL INVESTIGATION UNIT
FLOOR

FORENSIC LAB SERVICES
DIRECTORATE

FIRST NATIONS COMMUNITY
POLICE SERVICE

FIELD OPERATIONS SUPPORT
SYSTEM

FEDERAL OPERATIONS TEAM
FINGERPRINT SECTION
FREDERICTON

FREEWAY

FEDERAL SERVICES DIRECTORATE
FINANCE & SUPPLY DIRECTORATE
FINANCIAL SERVICES & SUPPLY

G

GENERAL DELIVERY

GRAND FALLS-WINDSOR DISTRICT
GENERAL HEADQUARTERS
GENERAL INVESTIGATION SECTION
GOODS AND SERVICES TAX
GREATER TORONTO
ENFORCEMENT SECTION

H

HALIFAX

HIGHWAY PATROL
HEADQUARTERS

HALIFAX REGIONAL POLICE
HEIGHTS

HAPPY VALLEY-GOOSE BAY
HIGHWAY

INTERNATIONAL AIRPORT
INFORMATICS BRANCH

IN CHARGE

INTELLIGENCE & CONTRABAND
INSURANCE CORPORATION OF
BRITISH COLUMBIA
INTERNATIONAL CUSTOMS
ENFORCEMENT SYSTEM
INSURANCE CRIME PREVENTION
BUREAU

INFORMATICS DIRECTORATE
IDENTIFICATION

IMMIGRATION & FEDERAL BRANCH
INFORMATICS FIELD SUPPORT
BRANCH

INTEGRATED INTELLIGENCE
ENFORCEMENT UNIT
IMMIGRATION INVESTIGATIVE
SERVICE
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1&ISD

1JIS

ILB
IL&POD

IMS

IMU
INFO
INSET

INST

INTELL
INTERN
INTERPOL
INT'L
INVEST
IPOC
IP/1&P
IPPC

IPS

IPSO

ISTB

U
IWRC

JCT
JFO
JPST
JSFU

L DIST
LAB

LB
LBPIAP

LIT
LMD

MB
MBC
MCU
METRO
MGR
MGT
MIIU

M.LEG

MPIC

MRU

MTD
MTN
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INFORMATION & IDENTIFICATION
SERVICES DIRECTORATE
INTEGRATED JUSTICE
INFORMATION SYSTEM
INTERNATIONAL LIAISON BRANCH
INTERNATIONAL LIAISON &
PROTECTIVE

OPERATIONS DIRECTORATE
INFORMATION MANAGEMENT
SECTION

INFORMATION MANAGEMENT UNIT
INFORMATION/INFORMATICS
INTEGRATED NATIONAL SECURITY
ENFORCEMENT TEAM
INSTITUTES/ INSTITUTION /
INSTITUTIONAL

INTELLIGENCE

INTERNAL

INTERNATIONAL POLICE
INTERNATIONAL
INVESTIGATION/INVESTIGATIVE
INTEGRATED PROCEEDS OF CRIME
IMMIGRATION & PASSPORT
INTEGRATED POLICE PLANNING
COMMITTEE

IMMIGRATION & PASSPORT
SECTION

INSTITUTIONAL PREVENTIVE
SECURITY OFFICER

INFORMATION SYSTEM &
TECHNOLOGY BRANCH
INVESTIGATION UNIT
IMMIGRATION WARRANT RESPONSE
CENTRE

J

JUNCTION

JOINT FORCES OPERATIONS
JOINT POLICE SECURITY TEAM
JOINT SECURITY FRAUD UNIT

L

LABRADOR DISTRICT
LABORATORY

LESTER B.

LESTER B. PEARSON
INTERNATIONAL AIRPORT
LITIGATION

LOWER MAINLAND DISTRICT

M

MANITOBA

MIGRATORY BIRD CONTROL
MAJOR CRIMES UNIT
METROPOLITAN

MANAGER

MANAGEMENT

METRO INTEGRATED INTELLIGENCE
UNIT

MAIN LEGISLATIVE

MAIN OFFICE

MANITOBA PUBLIC INSURANCE
CORPORATION

MOBILE RESPONSE UNIT
MOUNT

MOUNTED

MOUNTAIN

MTRL
MUN
MVB

N
NAT'L
NB
NCIB

NCIC
NCIS

NCM
NCO
NE
NEN
NF
NHQ
NICB

NLETS
NP DIST

NSI

oC
occC

OcCs
olc,0l/iC
oIS

ON
oP

OPF
OPP
OPS

OPS.OFF.

ORI:
0SS
oTT

P.A.B.
PA&ID

PB

PCA
PCI

PD
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MONTREAL
MUNICIPAL
MOTOR VEHICLES BRANCH

N

NORTH

NATIONAL

NEW BRUNSWICK

NATIONAL CRIME INTELLIGENCE
BRANCH

NATIONAL CRIME INFORMATION
CENTER

NATIONAL CRIME INTELLIGENCE
SECTION

NON-COMMISSIONED MEMBER
NON-COMMISSIONED OFFICER
NORTH EAST

NORTH EAST NOVA
NEWFOUNDLAND

NATIONAL HEADQUARTERS
NATIONAL INSURANCE CRIME
BUREAU

NATIONAL LAW ENFORCEMENT
TELECOMMUNICATIONS SYSTEM
NORTHERN PENINSULA DISTRICT
NOVA SCOTIA

NATIONAL SECURITY INTELLIGENCE
SERVICE

NATIONAL SECURITY INTELLIGENCE
SERVICE

NATIONAL SECURITY
INVESTIGATIONS UNIT
NETWORK SERVICES SECTION
NORTH WEST

NORTHWEST TERRITORIES
NUNAVUT

o

OFFICER COMMANDING
OPERATIONAL COMMUNICATIONS
CENTRE

ORGANIZED CRIME SECTION
OFFICER IN CHARGE
OPERATIONAL INFORMATION
SYSTEMS

ONTARIO

OPERATIONAL

ONTARIO POLICE FORCES
ONTARIO PROVINCIAL POLICE
OPERATIONS

OFFSHORE SURV.

OPERATIONS OFFICER OFFSHORE
SURVEILLANCE

ORIGINATOR NUMBER
OPERATIONAL SUPPORT SECTION
OTTAWA

P

PORT-AUX-BASQUES

PUBLIC AFFAIRS & INFORMATION
DIRECTORATE

PRIVACY BRANCH

POSTAL CODE

POLICE CAR ACCIDENTS

PUBLIC COMPLAINTS
INVESTIGATIONS

POLICE DEPARTMENT
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PDRC
PDS

PEN
PERS
PEU
PF
PIRS

PK
PI
PLID

POC
POE
POL
PORNO
PPD

PROB
PROT
PROV
PPS

PSP

PSU

PVT

P-W DIST

QcC

RCMP

RD
REC
RECNST
REG
REGISTR
REL

RHQ

RIIU

RM

RMS
RPC
RPO
RPU
RR

RTE

SAS
SCQ
scs
scu

S/D
S/DET

SEC
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POST DETERMINATION REFUGEE
CLASS

POLICE DOG SERVICES

PRINCE EDWARD ISLAND
PENITENTIARY

PERSONNEL

PARKING ENFORCEMENT UNIT
POLICE FORCE

POLICE INFORMATION RETRIEVAL
SYSTEM

PARK

PLACE

PLAIN LANGUAGE IDENTIFIER
POST OFFICE

PROCEEDS OF CRIME

PORT OF ENTRY

POLICING
PORNOGRAPHY/PORNOGRAPHIC
PROTECTIVE POLICING
DIRECTORATE

PROBATION
PROTECTION/PROTECTIVE
PROVINCIAL

POLICE SERVICE(S)

POLICE SUPPORT PROGRAMS
PERSONNEL SECURITY UNIT
PRIVATE
PLACENTIA-WHITBOURNE DISTRICT

Q
QUEBEC (CITY/PROVINCE)
R

ROYAL CANADIAN MOUNTED
POLICE

ROAD

RECORDS

RECONSTRUCTION
REGION/REGIONAL
REGISTRATION/REGISTRY
RELATIONS

REGIONAL HEADQUARTERS
REGINA INTELLIGENCE
INTEGRATED UNIT

ROOM/RURAL MUNICIPALITY
RECORDS MANAGEMENT SECTION
REGIONAL PSYCHIATRIC CENTRE
POSTAL OUTLET

REFUGEE PROCESSING UNIT
RURAL ROUTE

ROUTE

SOUTH

SEXUAL ASSAULT SECTION
SECURITY & QUALITY CONTROL
SERIOUS CRIME SECTION
SERIOUS CRIME UNIT/SECURITY
CLEARANCE UNIT

SUB-DIVISION
SUB-DETACHMENT

SOUTH EAST

SECTION

SECUR
SERV
SEU
SID
SIS
SIU
SK
s/o
SPL
sQC
SQUAD
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SECURITY
SERVICE(S)

SPECIAL ENFORCEMENT UNIT
STATE IDENTIFICATION

SPECIAL INVESTIGATION SECTION
SPECIAL INVESTIGATION UNIT
SASKATCHEWAN

SUB-OFFICE

SPECIAL
SECURITY & QUALITY CONTROL
SQUADRON

SR. RES OFFICER SENIOR REGIONAL ENFORCEMENT

SS

ST
ST/STE
STN
SUB-REG
SwW

SYS

TA
TC DIST
T&D
TECH
TELECOM
TEMP

TF
TLBPIA

TOD

TOR
TOSS

TPOF

TSO
TWP

VANC
VCAS
VICLAS

VIIU
VIN

VIP
VS

WARR
WE&EI

WL&AP
WPG

YT
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SERVICES OFFICER
SECURITY SERVICE
STREET

SAINT(E)

STATION
SUB-REGISTRY
SOUTH WEST
SYSTEM(S)

T

TEMPORARY ABSENCES
TRINITY CONCEPTION DISTRICT
TRAINING & DEVELOPMENT
TECHNICAL
TELECOMMUNICATIONS
TEMPORARY

TASK FORCE

TORONTO LESTER B. PEARSON
INTERNATIONAL AIRPORT
TECHNICAL OPERATIONS
DIRECTORATE

TORONTO

TECHNICAL OPERATIONS SUPPORT
SYSTEM

TECHNICAL AND PROTECTIVE
OPERATIONS FACILITY
TAXATION SERVICE OFFICE
TOWNSHIP

\%

VANCOUVER

VIOLENT CRIME ANALYSIS SECTION
VIOLENT CRIME LINKAGE ANALYSIS
SYSTEM

VANCOUVER INTEGRATED
INTELLIGENCE UNIT

VEHICLE IDENTIFICATION NUMBER
VERY IMPORTANT PERSONS
VICTIMS' SERVICES

w

WEST
WARRANT(S)

WILDLIFE ENFORCEMENT AND
ENVIRONMENT INTELLIGENCE
WATER, LAND & AIR PROTECTION
WINNIPEG

Y

YUKON TERRITORY
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AB

ACT
AD&I
ADM
ADRC
APPL

AV

BC
BCS

BDNC
BOUL

BRQCO
BST
BUR

CAAF
CAF
CANT
CDT S.-DIV.
CE

CH
CiCc
CIpPC
CIsCP
Clv
CJs
CO
COMM

CONTR
CONURB
COORD
cp

CcQ
CR
CRIM
CRPQ
CRU
CSSP
CTE
CTR

D-5

DC
DEC
DEV

DIR
DIST
DIV
DSTEC
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French Abréviations et Equivalents

A

ALBERTA

AGENT DE LIAISON

ACTIVITE

ACCISE, DOUANES ET IMPOT
ADMINISTRATION/ADMINISTRATIVE

AGENCE DES DOUANES & DU REVENU DU CANADA
APPLICATION

ABSENCES TEMPORARIES

AVENUE

B

COLOMBIE-BRITANNIQUE

BUREAU CONTROLE DES SOURCES

BUREAU DE LIAISON

BANQUE NATIONAL DES DONNEES CRIMINELLES

BOULEVARD

BUREAU REGIONAL

BUREAU DE RECHERCHES DU QUEBEC SUR LE CRIME ORGANIZE
BUREAU SERVIENCE DE TERRITOIRE

BUREAU

C

CERTIFICATE D'ACQUISITION D'ARME A FEU
CONTROLEUR DES ARMES A FEU

CANTON

COMMANDANT SOUS-DIVISIONNAIRE
CONTROLE DES EFFETS

CHEMIN

CITOYENNETE ET IMMIGRATION CANADA

CENTRE D'INFORMATION DE LA POLICE CANADIENNE
CENTRE D'INFORMATION DES SERVICES CANADIENS DE POLICE
CIVIL(E)

CASIERS JUDICIARIES SYNOPTIQUES
CENTRED'OPERATION

COMMUNAUTE/

COMMUNICATIONS/COMMUTATION

CONTROLE

CONURBATION

COORDINATION/COORDONNATEUR

CASIER POSTAL

CONTROLE QUALITE

CRIMINEL(LES)

CRIMINEL(LES)

CENTRE DE RENSEIGNEMENTS POLICIERS DU QUEBEC
CENTRE RENVOIS UNIFIE

CENTRE SERVICE EN SECURITE PUBLIQUE

COMTE

CENTER

D

DISTRICT 5

COUANES ET ACCISE

DELITS COMMERCIAUX

DIVISION DES ENQUETES

DEVELOPPEMENT

DIRECTION GENERALE

DIRECTION

DISTRICT

DIVISION(NAIRE)

DIVISION SOUTIEN TECHNIQUE ENQUETES CRIMINELLS

E
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E EST
EC ENQUETES CRIMINEL (LES)
ECM ESCOUADE CRIMINAL MAJEURS
EC/ST ENQUETES CRIMINEL(LES) /SUPPORT TECHNIQUE
ECO ESCOUADE CRIME ORGANISE
EF ENQUETES FRONTALIERES
EG ENQUETES GENERALES
ENQ ENQUETES
ERAM ESCOUDE REGIONALE ALCOOL ET MORALITE
ERM ESCOUADE REGIONALE DES MOEURS
ES ENQUETES SPECIALES /SPECIALISEES
ESS ENQUETES SPECIAL SECURITE
ETAB ETABLISSEMENT
F
FED FEDERAL(ES)
FIN FINANCIER/FINANCIERES
FIN FICHIER JUDICIAIRE NOMINATIF
G
GClI GROUPE DE CONTROLE ET DE L'INFORMATION
GEN GENERAL (E)
GOUVERN GOUVERNEMENT
GPC GROUPE DES PRODUITS DE LA CRIMINALITE
GQG GRAND QUARTIER GENERAL
GRC GENDARMERIE ROYALE DU CANADA
H
HUM HUMAINES
|
ICJ INFORMATION DES CASIERS JUDICIAIRES
ID IDENTITE
IND: INDICATIF
INFO INFORMATION/INFORMATIQUE/
INFORMATISES
INT'L INTERNATIONALE
P IMMIGRATION ET PASSEPORT
IRC INTERVENTION REGION CENTRE
J
JuD JUDICIAIRE
L
LOC LOCAL
M
M/MON MONITEUR
MAT MATERIEL
MB MANITOBA
MDN MINISTERE DE LA DEFENSE NATIONALE
MGR MONSEIGNEUR
MIG MIGRATION
MLLL MONTREAL, LAVAL, LAURENTIDES & LANAUDIER
MRC MUNICIPALITE REGIONALE DE COMPTE
MSI MONITEUR SYSTEMES INFORMATISES
MT MONT
MTRL MONTREAL
MUN MUNICIPAL
N
N NORD
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NAT'L NATIONAL(E)
NB NOUVEAU-BRUNSWICK
NE NORD-EST
NF TERRE-NEUVE
NIV NUMEROS D'IDENTIFICATION DE VEHICULES
NOR NORANDA
NOuvV NOUVEAU
NS NOUVELLE-ECOSSE
NT TERRITOIRES DU NORD-OUEST
NU NUNAVUT
)
) OUEST
OFF. OFFICIER
OFF.DIV. OFFICIER DIVISIONNAIRE
OFF. RESP. OFFICIER RESPONSIBLE
OIX OISEAUX
ON ONTARIO
OP/OPER OPERATIONNEL (LES)
P
PC PRODUITS DE LA CRIMINALITE
PDQ POSTE DE QUARTIER
PE ILE-DU-PRINCE EDOUARD
POL POLICERES
PR PATROUILLE ROUTIERE
PROM PROMENADE
PROT PROTECTION
Q
QC QUEBEC (VILLE OU PROVINCE)
QG QUARTIER GENERAL
QGD/QG QUARTIER GENERAL DE DISTRICT
DISTRICT
QU/QUAL QUALITE
R
RACJ REGIE ALCOOL COURSES ET JEUX
RC RENSEIGNEMENTS CRIMINALS
REG REGION/REGIONAL(E)
REL RELATIONS
RENS RENSEIGNEMENT(S)
REPRESS REPRESSION
RESP RESPONSABLE
RESS RESSOURCES
ROUT ROUTIER/ROUTIERE
RS RENSEIGNEMENTS SECURITE
RSO RAPPORTS STATISTIQUES SUR LES OPERATIONS
RTE ROUTE
S
S SUD
SAAQ SOCIETE ASSURANCE AUTOMOBILE QUEBEC
SARC SYSTEME AUTOMATISE DES RENSEIGNEMENTS CRIMINELS
SAU SERVICES AUX USAGERS
SCC SERVICE CORRECTIONNEL CANADA
SCQ SERVICE CORRECTIONAL DU QUEBEC
SCRS SERVICE CANADIEN DU RENSEIGNEMENT+DE SECURITE
SD SERVICE DIVISIONNAIRE
S-D SOUS-DIVISION
SDAIC SERVICE DIVISIONNAIRE DES ANALYSES DES INFORMATIONS CRIMINELLES
SDC SECTION DES DELITS COMMERCIAUX
SDEC SERVICE DIVISIONNAIRE DES ENQUETES
CRIMINELLES
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S-DIC SOUS-DIRECTION DES INFRACTIONS

COMMERCIALES
S.-DIv. SOUS-DIVISION
S.-DON/
S.-DIRECTION SOUS DIRECTION
SDRC SERVICE DIVISIONNAIRE RENSEIGNEMENTS CRIMINELS
SEC SECURITE
SECT SECTION
SEEA SECTION ENQUETES ECONOMIQUES

ANTIDROGUE
SEF SECTION ENQUETES FRONTALIERES
SEG SECTION ENQUETES GENERALES
SELF SECTION ENQUETES LOIS FEDERALES
SEM SEMAINE
SENS SENSIBILISATION
SERV SERVICE(S)
SESN SECTION ENQUETES RELATIVES A LA SECURITE NATIONALE
SESS SERVICE ENQUETES SPECIALE SECURITE
SFD SERVICE FRONTALIER DES DOUANES
SKFJ SECTION DU FICHIER/JUDICIAIRE
SLAD SECTION LUTTE ANTIDROGUE
SM SURETE MUNICIPAL DU QUEBEC
S.OFF. RESP SOUS-OFFICIER RESPONSABLE
SP SERVICE DE POLICE
SPC SECTION POLICE CRIMINELLE
SPCUM SERVICE DE POLICE DE LA COMMUNAUTE

URBAINE DE MONTREAL
SPEC SPECIAL(E)
SPPCAD SECTION DE LA PROTECTION DES

PERSONNALITES CANADIEN ET AGENTS DIPLOMATIQUES
SPVM SERVICE DE POLICE DE LA VILLE DE MONTREAL
SQ SURETE DU QUEBEC
SRAC SECTION RENSEIGNEMENTS ET ANALYSES CRIMINALS
SRC SECTION/SERVICE DES RENSEIGNEMENTS CRIMINELLES
SRCMD SECTION DES RENSEIGNEMENTS CRIMINELS MORALITE ET DROGUE
SRCQ SERVICE DES RENSEIGNEMENTS CRIMINELLES DU QUEBEC
SRR SYSTEME DE RAPPORTS DE POLICE
SR/TR SECURITE ROUTIERE ET TRANSPORT ROUTIER
SS SERVICE DE SECURITE
SSID SECTION SECURITE INTEGRATION DES DONNEES
SSR SECTION DES SERVICES DU RESEAU
ST/STE SAINT(E)
STO STATION DE TRANSMISSIONS OPERATIONNELLES
succ SUCCURSALE
SUPP SUPPORT
SUR SURETE
SURV SURVEILLANCE
SYST SYSTEME(S)

T

TECHN TECHNIQUE
TELECOMM TELECOMMUNICATIONS
TEMIS TEMISCAMINGUE
TERR TERRITOIRE
TRAF TRAFIQUANTS
TRANSM TRANSMISSION
TRANSP TRANSPORT
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ULF

URC
URCOMM
URS

USR
USRTR
USTEC

VERIF.

YT

www.dmtispatial.com

UNITE DES LOIS FEDERALES

UNITE RENSEIGNEMENTS CRIMINELS

UNITE RELATIONS COMMUNATAIRE

UNITE RENSEIGNEMENTS SECURITE

UNITE SECURITE ROUTIERE

UNITE SECURITE ROUTIERE ET TRANSPORT ROUTIER
UNITE SOUTIEN TECHNIQUE ENQUETES CRIMINELS

\%

VERIFICATION

YUKON
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Appendix H: 1SO 19115:2003 Compliant Metadata

Metadata Notification

As of May 15" 2005, DMTI Spatial data products have metadata that are IS0 19115:2003 compliant.
This product now includes structured metadata files as provided in XML and/or HTM format. These
metadata files reside with the graphic or database files to which they are associated. It is recommended

that users review and customize the metadata as per their specific needs.

This latest addition to the CanMap® line of products is another enhancement that will benefit our users
and increase overall product satisfaction.
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